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FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to

Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio or television
reception. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause interference to radio and television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following
measures.

»  Reorient or relocate the receiving antenna.

»  Increase the separation between the equipment and receiver.

»  Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
»  Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification of this device and may cause interference levels which exceed the limits established by the FCC for
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this
device. If this equipment has more than one interface connector, do not leave cables connected to unused
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le materiel brouilleur du
Canada.
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Also included are the
EPSON Plot! program
and the Autodesk Device
Interface (ADI) plotter
driver. EPSON Plot!
allows you to print

HPGL or HPGL/2 plot
files on your printer. See
Appendix B for details.
The ADI driver allows you
to print from AutoCAD 386
releases 10 and higher.
See the README file on
the driver diskette for
more information.

Introduction

Your EPSON Stylus® COLOR 3000 printer is the ideal output
device for high-quality, large format graphic and business
communication pieces—such as color comps, checkplots, maps,
presentations, banners, iron-on transfers, and backlit displays—
or any project you create. With resolutions up to 1440 x 720
dpi (dots per inch), you get amazingly realistic photographic
images, vivid color graphics, superb grayscale images, and
razor-sharp black printing for detailed line art and crisp text.

Its large format capabilities (up to 17" x 22" size paper) and fast
print speeds allow you to print full bleed, 13" x 197 photo
quality color comps with ease. And its versatile, built-in paper
feeding options let you print on virtually any media, of almost
any size, including single sheets, continuous fold paper, and roll
paper. You can even load continuous paper and single sheets
simultaneously, printing on each in turn by flipping a lever.

The printer software for Microsoft® Windows® and Apple®
Macintosh® computers provides advanced color management,
with adjustable levels of brightness, contrast, saturation, and ink
colors. Support for ColorSync™ 2.01 and Windows 95 ICM
ensures printouts that closely match the colors on your monitor.
You can also perform many printer maintenance procedures
right from your computer, such as cleaning and aligning the
print heads. And EPSON'’s extensive online help can guide you
through printer operations in real time.
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With standard parallel and high-speed serial ports and optional
network connectivity, setting up your printer is fast and easy.
EPSON'’s specially formulated, quick-drying ink and wide
variety of ink jet media give you the best quality output and the
most flexibility for getting the results you want.

PC System Requirements

To use your printer and its software with a PC, your system
should have:

» An IBM® compatible PC with at least a 386/25 MHz or
faster processor (486/66 MHz or faster for Windows NT)

» DOS, Windows 95, Windows 3.1x, Windows for
Workgroups 3.11, Windows NT 4.0 or 3.51

» Atleast 16MB of RAM

» At least 20MB of free hard disk space for storing images
(40MB or more is recommended, 50MB or more for
Windows NT)

» VGA, Super VGA, or better display adapter and monitor

»  Double-speed CD-ROM drive (quad-speed or faster
recommended) for installing the printer software

» Asshielded, twisted-pair parallel cable (6 to 10 feet long) to
connect your computer to the printer; the cable must have
a D-SUB, 25-pin, male connector for your computer and a
36-pin, Centronics® compatible connector for the printer.

For PC network interface options and the additional system
requirements they may have, see Appendix A.
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Macintosh System Requirements

To use your printer and its software with a Macintosh, your
system should have:

» Any Macintosh or Power Macintosh® model except the
Macintosh +, Macintosh 512, Performa® 410,
PowerBook® 100, and some early versions of the
Macintosh such as the 11 or Classic

»  System 7.1 (System 7.5 or later is recommended)

» At least 8MB of built-in RAM (16MB or more is
recommended)

» Double-speed CD-ROM drive (quad-speed or faster
recommended) for installing the printer software

» At least 20MB of free hard disk space for storing images
(40MB or more is recommended)

» VGA, Super VGA, or better display adapter and monitor

»  Standard Apple System Peripheral-8 serial cable or
equivalent (RS-422, 8-pin mini DIN male/male)

For Macintosh network interface options and the additional
system requirements they may have, see Appendix A.

How To Use Your Manuals

To set up your printer and install your printer software, see the
Quick Setup booklet. This User’s Guide contains the following
information:

Chapter 1, “Basic Printing,” gives step-by-step instructions for
everyday printing with Windows or Macintosh.

Chapter 2, “Custom Printing,” tells you how to print special
projects with custom settings for print quality, special effects,
and color management.
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Chapter 3, “Printing on Special Media,” gives guidelines for
selecting the right paper or other media for your print job and
instructions for loading it in your printer.

Chapter 4, “*Managing Print Jobs and Network Printing,”
explains how to manage print jobs, check printer status, and set
up your system for network printing.

Chapter 5, “Using Your Printer with DOS,” tells you how to
use your printer with DOS applications, including selecting
printer software for DOS, changing printer settings using
default-setting mode, aligning the print heads, selecting
character tables, and using printer commands.

Chapter 6, “Maintenance and Transportation,” gives
instructions for replacing ink cartridges, cleaning and aligning
the print heads, and cleaning and transporting the printer.

Chapter 7, “Troubleshooting,” provides solutions for any
printing problems you may have.

Appendix A, “Using Optional Interfaces,” lists the optional
interface boards and gives instructions for installing and using
them.

Appendix B, “Using EPSON Plot!,” gives instructions on how
to install and use the EPSON Plot! program to print HPGL or
HPGL/2 plotter files.

Appendix C, “Specifications,” provides the technical details on
your printer, ink cartridges, and EPSON media.

A Glossary and an Index are included at the end of the book.
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Warnings, Cautions, Notes, and Tips
You'll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.

Where To Get Help

EPSON provides customer support and service through a
network of authorized EPSON Customer Care Centers. Dial
(800) 922-8911 for the nearest location or the following
services:

»  FaxAdvice access to EPSON'’s technical information library
» Literature on current and new products

» The location of your nearest Authorized EPSON Reseller or
Customer Care Center

» Technical information on the installation, configuration,
and operation of EPSON products

» Customer relations

For answers to commonly asked questions about EPSON
products 24 hours a day, seven days a week, call EPSON Sound
Advice at (800) 442-2110.
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You can purchase ink cartridges, paper, manuals, accessories,
and parts from EPSON Accessories at (800) 873-7766 (U.S.

sales only). In Canada, please call (800) 873-7766 for dealer
referral.

If you need help using software with an EPSON product, see
the documentation for that program for technical support
information.

Electronic Support Services

You can access helpful tips, specifications, DIP switch or
jumper settings, drivers, FAQs, sample files, application notes,
and EPSON product bulletins 24 hours a day, seven days a
week, using a modem and one of the online services below.

World Wide Web

From the Internet, you can reach EPSON’s Home Page at
http://www.epson.com.

EPSON Download Service

You can call the EPSON Download Service at (800) 442-2007.
Set your communications software to 8 data bits, 1 stop bit, no
parity. Modem speed can be up to 28.8 Kbps.

EPSON FaxAdvice Service

You can access EPSON'’s technical information library by
calling (800) 442-2110 and selecting the appropriate phone
option. You must provide a return fax number to use
FaxAdvice.
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EPSON Forum on CompuServe

Members of CompuServe® can type GO EPSON at the menu
prompt to reach CompuServe’s Epson America Forum. As an
owner of an EPSON product, you are eligible for a free
introductory CompusServe membership, which entitles you to
an introductory credit and your own user ID and password.
To take advantage of this offer in the U.S. or Canada, call
(800) 848-8199 and ask for representative #529.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this
product meets the ENERGY STAR guidelines for energy
efficiency.

The EPA ENERGY STAR Office Equipment program is a
voluntary partnership with the computer and office equipment
industry to promote the introduction of energy-efficient
personal computers, monitors, printers, fax machines, and
copiers in an effort to reduce air pollution caused by power
generation.

Energy-saving Tips
Here are a few tips you can use to be even more energy-wise:

» If your monitor isn’t ENERGY STAR compliant, turn it off
when you’re not using it.

»  Turn off your computer, printer, and monitor each day
when you are done using them.

»  Use the print preview option in your software so you can
catch errors before you print something.

» Send e-mail rather than distributing memos. Not only is
this faster, but you’ll save paper and storage space too.
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Important Safety Instructions

Before using your printer, read the following safety instructions
to make sure you use the printer safely and effectively.

Turn off and unplug the printer before cleaning. Clean
with a damp cloth only. Do not spill liquid on the printer.

Do not place the printer on an unstable surface or near a
radiator or heating vent.

Do not block or cover the openings in the printer’s cabinet
or insert objects through the slots.

Use only the type of power source indicated on the printer’s
label.

Connect all equipment to properly grounded power
outlets. Avoid using outlets on the same circuit as
photocopiers or air control systems that regularly switch
on and off.

Place the printer near a wall outlet where the plug can be
easily unplugged.

Placez I'imprimante prés d’une prise de contacte ou la fiche
peut étre débranchée facilement.

Do not let the power cord become damaged or frayed.

If you use an extension cord with the printer, make sure
the total ampere rating of the devices plugged into the
extension cord does not exceed the cord’s ampere rating.
Also, make sure the total of all devices plugged into the wall
outlet does not exceed 15 amperes.

Except as specifically explained in this User's Guide, do not
attempt to service the printer yourself.
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Unplug the printer and refer servicing to qualified service
personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered
the printer; if the printer has been dropped or the cabinet
damaged; if the printer does not operate normally or
exhibits a distinct change in performance. Adjust only those
controls that are covered by the operating instructions.

Note the following precautions when using a printer stand with
this printer:

Use a stand that can support at least 66.0 Ib (30.0 kg).

Never use a stand that tilts the printer. The printer should
always be kept level.

Position your cables so they do not interfere with paper
feeding; where possible, secure them to a leg of the printer
stand.

Even if you are familiar with other types of printers, be sure to
read through the following list of precautions before operating
your ink jet printer;

Do not put your hand inside the printer or touch the print
heads during printing.

Under normal circumstances, ink will not come out of the
cartridges. If it does get on your skin, wash it off with soap
and water. If it gets in your eyes, flush them immediately
with water.

Keep ink cartridges out of the reach of children.

Do not dismantle the ink cartridges or try to refill them.
This could result in damage to the print head.

Once you install an ink cartridge, do not remove the
cartridge except to replace it with a new one. The cartridge
may become unusable otherwise.

Install the ink cartridge immediately after you remove it
from its package. Leaving the cartridge unpacked for a long
time before use may result in reduced print quality.
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Do not use an ink cartridge beyond the date printed on the
cartridge carton. For best results, use up the ink cartridges
within six months of installing them.

Do not shake an ink cartridge; this can cause leakage.

Always turn the printer off using the & Operate button.
When this button is pressed, the Operate light flashes
briefly then goes out. Do not unplug the printer or turn off
the power to the outlet until the Operate light is off.

Before transporting the printer, make sure the print heads
are capped in the home (far right) position and the ink
cartridges have been removed.
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If you print from
DOS applications,
see Chapter 5 for
instructions.

For instructions on
printing HPGL or
HPGL/2 plot files,
see Appendix B.

@ 1 Basic Printing

It’s easy to print all your color and black-and-white documents
with your EPSON Stylus COLOR 3000. First you have to set up
your printer and install the software following the instructions
in the Quick Setup booklet. Then read this chapter to find out
about the following:

»  Printing from Windows
»  Printing from a Macintosh
» Using online help

»  Using the control panel

Printing from Windows

When you want to print from your Windows application, you
choose Print from the File menu. You can then choose which
pages to print, the number of copies, and other options from
your application’s Print dialog box. When you click a button in
the Print dialog box, you can select additional settings using
your printer software, such as whether you want to use color or
black ink.

The following sections tell you how to do the following:
»  Set printer software options from Windows applications
»  Change the default printer software settings

»  Check your printer’s status while you print.
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The settings you select
through your Windows
application usually apply
only until you exit that
application. Then the
driver settings may return
to the driver’s default
values or the Windows
default values selected as
described on page 1-5.

Ly

For more information
about printer settings,
click the Help button.
With Windows 95 and
Windows NT, you can
right-click any item on
the screen and then click
What'’s This?

Setting Printer Options from Windows
Applications

This section describes the options you’ll need to set for all your
everyday printouts. See Chapter 2 for information about
advanced settings for special print jobs.

Follow these steps to check printer settings from your word
processor or other Windows software:

1. Choose Print or Print Setup from the File menu.

If you choose Print, you first see your application’s Print
dialog box containing the settings you change most often,
including the number of copies and the pages you want
printed.

If you choose Print Setup, you first see a list of printers to
choose from.

2. Make sure your EPSON Stylus COLOR 3000 printer is
selected, and then click the Printer, Setup, Properties, or
Options button.(You may have to click a series of these
buttons, depending on the program you’re printing with.)
You see the printer software’s dialog box:
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For printing at the highest
resolution (SuperFine
quality at 1440 dpi), you
need to use one of the
photo quality media, the
back light film, or the
canvas cloth. For the best
printing at any resolution,

always use EPSON media.

N\
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Note:

The media selection on
the control panel can be
overridden by the Media
Type setting you make in

your printer driver or
application.

The control panel
selection notifies you in
case the media loaded in
the printer does not match
the media you selected in
the software. You can
turn off the notification
function by selecting
Other/Media Selection
Off.

3.

Basic Printing

If you don’t see the dialog box shown in step 2, click the
Main tab.

Make sure the Mode option is set to Automatic so the
printer software can determine the best settings according
to the Media Type and Ink settings you make. This is the
easiest way to get good printing results for all kinds of
documents, on all types of paper.

Choose the Media Type you want to print on from the
following list (you may need to scroll through the list). If
you are not sure which setting to select for your media, refer
to the table on page 3-3.

» Plain paper

» 360 dpi Ink Jet Paper

» Photo Quality Ink Jet Paper
» Photo Quality Glossy Paper
» Photo Quality Glossy Film

» Ink Jet Transparencies

» Ink Jet Back Light Film

» Ink Jet Canvas Cloth

The type of media you choose determines the Print Quality
setting (resolution) you can use.

If you are using Windows 95, press Media Type button on
the printer’s control panel to select the media you loaded in
the printer and selected in step 5. If your media type is not
listed on the control panel, select Other/Media Selection
Off.

Choose Color or Black ink. If you're printing black text or
a draft, or if you want colors to print as varying shades of
gray, select Black for faster printing.
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Whenever you change the
Paper Source, Paper Size,
or Orientation settings,
check the printer
illustration in the dialog
box to see how your
document will print.

If you load your paper
long edge first, select a
landscape paper size, such
as Letter (Landscape), and
then select your print
orientation so the printer
knows which way you
loaded the paper.

Keep in mind that some
software may have paper
size and orientation
settings that override your
printer software settings.

To cancel your changes
and exit the driver, click
the Cancel button at the
bottom of the menu at
any time.

8.

10.

11.

Set the slider to Quality or Speed. This lets you choose
between high resolution printing or faster printing on the
media you're using. (The slider is not available for certain
media types and may not set the highest available
resolution.)

Click the Paper tab and choose your paper feeding source.

The default Paper Source is Auto Sheet Feeder, for the
paper tray at the front of your printer. (For instructions on
printing with the other feeders, see Chapter 3.)
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Now choose the paper size, number of copies, collation
options, orientation, and printable area. (Your software
application may let you control some of these settings.
With Windows NT, there are no collation options.)

Click the Main tab and check the Current Settings box on
the bottom of the menu to see if the other settings are
correct for your document. If you need to adjust them, use
Advanced mode as described in Chapter 2.
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Some application settings
override printer software
settings (such as Paper
Size or Orientation), so

it is a good idea to check
the settings in your
application before you
print.

Basic Printing

12. Click OK when you're finished checking your settings. The
dialog box closes.

13. In your application’s printing dialog box, click Close, OK,
or Print. (You may need to click a series of these buttons,
depending on the program you’re printing with.)

While you're printing, the EPSON Despooler dialog box
appears, showing the printing progress and the status of your
printer. (With Windows NT, you don’t see the Despooler.) See
“Checking Printer Status” on page 1-7 for more information.

Setting Default Printer Options

When you change printer settings through your Windows
application (as described above), the settings apply only to the
application you’re using. If you want to adjust the default
settings for all your Windows applications, you can access the
printer software through the Windows 95 or Windows NT
Printer Properties or the Windows 3.1 Control Panel.

Make sure all your software applications are closed before you
start. If not, you'll have to close and then reopen them to have
the new default settings take effect.

Setting Default Options in Windows 95
1. Click Start, point to Settings, and then point to Printers.
2. Right-click the EPSON Stylus COLOR 3000 icon.

3. Select Properties, then click the Main tab. You see the
Main printer settings dialog box.

4. Change the settings as described on page 1-2 and click OK.
Any changes you make become the default settings for all
your applications and documents.
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Note:

You can access the
default Windows NT
printer software settings
only if you have the
appropriate network
access privileges, such

as Administrator or
Power User.

Setting Default Options in Windows 3.1

1.

2.

Double-click the Control Panel icon in the Main group.
Double-click the Printers icon.

Select EPSON Stylus COLOR 3000 from the list of printers
and click Setup. You see the Main printer settings dialog
box.

Change the settings as described on page 1-2 and click OK.
Any changes you make become the default settings for all
your applications and documents.

Setting Default Options in Windows NT 4.0

1.

2.

Click Start, point to Settings, and then point to Printers.
Click the EPSON Stylus COLOR 3000 icon.

Open the File menu and select Document Defaults. You
see the Main printer settings dialog box.

Change the settings as described on page 1-2 and click OK.
Any changes you make become the default settings for all
your applications and documents.

Setting Default Options in Windows NT 3.51

1.

2.

Double-click the Control Panel icon in the Main group.
Double-click the Printers icon.

Select the EPSON Stylus COLOR 3000 printer window, if
necessary.

Open the Printer menu and select Properties.
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If you don’t want the
Despooler dialog box to
appear each time you
print, you can turn it off.
To do this, start Spool
Manager, open the View
menu, and select Show
Despool Popup; the
checkmark next to the
option disappears.

Basic Printing

5. Click Details, then click Job Defaults. You see the Main

printer settings dialog box.

6. Change the settings as described on page 1-2 and click OK.

Any changes you make become the default
your applications and documents.

Checking Printer Status

settings for all

While your document is printing, the EPSON Despooler dialog

box appears on your screen. (With Windows N

T, you don’t see

the Despooler. See the following section for more information.)

Status Monitor

(Windows 95 —

only)

Click to Cope 10l 1
it il P50

pause printing LBTH:

Clicktocancel ——— w | 1|

printing

The name of
the file you're
printing appears
—— here

| Click to
restart printing

This dialog box shows the progress of your print job and the

status of your printer. If you run out of paper,
Despooler warns you. You can use the buttons
or restart your print job, if necessary. When th
finished, the Despooler dialog box disappears.

for example, the
to cancel, pause,
e print job is



Basic Printing

If you are using Windows 95, the Status Monitor, as described
below, also appears.

» Media Check
A check in the Perform Media Check before printing box
means this function is selected (the default setting). The
Media Check function automatically compares the media
selected with the printer control panel with the media
selected in the printer driver and alerts you if they don’t
match. To turn off this function, click the box; the
checkmark disappears.

»  Paper Status
The Paper Status box displays information about the paper
loaded in the printer. You select the paper feed path in the
driver, and the Status Monitor checks the printer for the
size, type, and amount. The paper size and amount is
determined by the printer. The media type is defined
by the Media Type setting you make with the printer’s
control panel.

» Ink Status
The Ink Status box displays the amount of remaining ink
for each color.

Checking Printer Status with Windows NT

With Windows NT 4.0 servers and workstations, the messenger
service alerts you to printer errors or lets you know when a print
jobis finished. If you have appropriate network access privileges
or if you're controlling printing from the server, you can also
cancel, pause, or restart print jobs and set the sharing, security,
scheduling, and port options. See your Windows NT 4.0
documentation for details.

You can check the status of your print job in

Windows NT 3.51 using the Print Manager. Options

in the Print Manager window let you pause, resume, or
delete print jobs and handle the print queues on your
system, depending on your network access privileges. See
your Windows NT 3.51 documentation for instructions.
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Note: j

A Power Macintosh
Extension module
(EPSON Stylus
PowerPlug) was
automatically installed
and enabled when you
installed your printer
software. This module
accelerates rendering
and processing of all
documents on a Power
Macintosh.

\
Note: j

To cancel your changes

and exit the driver, click

the Cancel button at any
time.

Basic Printing

Printing from a Macintosh

When you print with a Macintosh, you need to check the
printer software settings for each application you use. This
section describes the settings you’ll need to choose for all your
everyday printouts. See Chapter 2 for information about
advanced settings for special print jobs.

1. Start the application you want to print from and create a
document.

2. Choose Page Setup from the File menu. You see the Page
Setup dialog box:

Click to select Click to select your
your paper size paper source

Faper brw
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3. First choose your paper feeding source. The default Paper
Source is Auto Sheet Feeder, for the paper tray at the
front of your printer. (For instructions on printing with the
other feeders, see Chapter 3.)

4. After selecting your paper source, choose the paper size,
orientation, reduction or enlargement, and printable area.
(Your software application may let you control some of
these settings.)

Click OK to close the Page Setup dialog box and continue.
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\
Note: :&

Whenever you change
the Paper Source, Paper
Size, or Orientation
settings, check the
printer illustration in the
dialog box to see how
your document will print.

If you load your paper
long edge first, select

a landscape paper

size, such as Letter
(Landscape), and

then select your print
orientation so the printer
knows which way you
loaded the paper.

Keep in mind that some
software may have
paper size and orientation
settings that override
your printer software
settings.

Tip

For printing at the highest
resolution (SuperFine
quality at 1440 dpi), you
need to use one of the
photo quality media, back
light film, or canvas cloth.
For the best printing at any
resolution, always use
EPSON media.

6. Choose Print from the File menu or click the print icon in

your application. You see a dialog box like the following:

Click for more information
about printer settings
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Click to select your media type

7. Choose the number of copies and indicate which pages you

want to print.

Make sure the Mode option is set to Automatic so the
printer software can determine the best settings according
to the Media Type and Ink settings you make. This is the
easiest way to get good printing results for all kinds of
documents, on all types of paper.

Choose the Media Type you want to print on from the
following list. If you are not sure which setting to select,
refer to the table on page 3-3.

» Plain Paper

» 360 dpi Ink Jet Paper

» Photo Quality Ink Jet Paper
» Photo Quality Glossy Paper
» Photo Quality Glossy Film

» Ink Jet Transparencies

» Ink Jet Back Light Film

» Ink Jet Canvas Cloth

The type of media you choose determines the Print Quality
setting (resolution) you can use.
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Note: j

The media selection on
the control panel can be
overridden by the Media
Type setting you make in
your printer driver or
application.

The control panel
selection is a reminder
to notify you in case the
media loaded in the
printer does not match
the media you selected in
the software. You can
turn off the notification
function by selecting
Other/Media Selection
Off.

Printer settings are saved
with your document, but
you can’t save them from
one application to another.
You’ll have to check your
settings each time you
print from a new
application. If you want
to reuse settings, you
can create document
templates for your favorite
applications.

10.

11.

12.

13.

Basic Printing

Press the Media Type button on the printer’s control panel
to select the media you loaded in the printer and selected in
step 9. If your media type is not listed on the control panel,
select Other/Media Selection Off.

Choose Color or Black ink. If you are printing black text
or a draft, or if you want colors to print as varying shades of
gray, choose Black for faster printing.

Set the slider to Quality or Speed. This lets you choose
between high resolution printing or faster printing on the
media you're using. (The slider is not available for certain
media types and may not set the highest available printer
resolution.)

Once you've changed these basic settings, check the
Current Settings box on the right side of the menu to see if
the other settings are correct for your document. If you
need to adjust them, use Advanced mode as described in
Chapter 2.

Click Print when you’re finished checking your settings.

If you chose background printing when you set up your
printer, you can continue working while your document is
printing. See “Using EPSON Monitor2” in Chapter 4.
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.O
With Windows 95 you can
get specific help related to
any item in the menus by
right-clicking the item and

then clicking the What'’s
This? prompt.

Using Online Help

For complete information about using the printer software, you
can easily access online help any time. It provides detailed
descriptions of the different settings and options.

Accessing Help from Windows Applications

To access online help from your application, open the File
menu and choose Print or Print Setup. Then click Printer,
Setup, Options, or Properties; you may need to click a series
of these buttons, depending on the software you're using. Click
the Help button at the bottom of the dialog box for help related
to the items on that dialog box. Then select a help topic. You
can also access online help when you’re not using the software,
as described below.

Accessing Help from Windows 95

Click the Start button, point to Programs, and Epson, and
then click EPSON Stylus COLOR 3000 Help. If you need
instructions for how to use help, read the online “Quick Guide
to Using Help.”

Accessing Help from Windows 3.1

To access online help from Program Manager, open the EPSON
program group and click the EPSON Stylus COLOR 3000 Help
icon. If you need instructions for how to use help, read the
online “Quick Guide to Using Help.”
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With Windows NT, you
can get specific help
related to any item in the
menus by right-clicking

the item and then clicking
the What’s This? prompt.

Basic Printing

Accessing Help from Windows NT 4.0

Click the My Computer icon, then click the Printers icon.
Right-click the EPSON Stylus COLOR 3000 icon and select
Document Defaults from the menu. In the printer software
dialog box, click the Help button. If you need instructions for
how to use help, read the online “Quick Guide to Using Help.

Accessing Help from Windows NT 3.51

Double-click the Control Panel icon in the Main group. Then
double-click the Printers icon. Select the EPSON Stylus
COLOR 3000 printer window, then open the Printer menu and
select Properties. Click Details, then click Job Defaults. In
the printer software dialog box, click the Help button. If you
need instructions for how to use help, read the online “Quick
Guide to Using Help.”

Accessing Help from Macintosh Applications

Choose Print from the File menu or click the print icon in your
application. Click the Help button for help related to the items
on that menu. To exit Help, click the OK button at the bottom
of the Help screen.
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Using the Control Panel

Operate light Ink Out
‘ lights
i Operate Ink Out W 0 Yellow Cleaning Cleaning
d) m ) Magenta Iy
T Paper Out (j m( Cyan D C]
Paper Out light — m () Black
Pause light = f3sec.  M3sec
Pause LF/FF
=[ ]: [ ] [ ] Media Type
5 Sec. 4+ M Plain Paper
Reset Micro AdeSt M 360 dpi Ink Jet Paper
Load/Eject 9 B Photo Quality Ink Jet Paper
B Photo Quality Glossy Film
[ ] [ ] M Ink Jet Transparencies
M Other/Media Selection Off
Media Type selection lights
Lights

The lights on your printer’s control panel show the printer’s
status and alert you to problems, such as paper jams or low ink.

Operate

The Operate light is on when the printer is on. When the
Operate light flashes, the printer is receiving data. It may
also flash with other lights during certain operations or
error conditions.

Paper Out @

When the Paper Out light comes on, your paper ran out
or is loaded incorrectly, or the paper-release lever is set to
the wrong position. Load paper, check the lever position

(see Chapter 3), and then press the Pause or Load/Eject
button to turn off the light.

When the Paper Out light flashes, you have a paper jam.
Turn off the printer, gently pull out all jammed paper,
reload the paper, and reload the paper. See Chapter 7 for
more information.
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Ink Out & Yellow

When an Ink Out light flashes, your ink supply is low.

&Magenta  Make sure you have a replacement cartridge.

éCyan .
When an Ink Out light comes on, you need to replace the

éBlack . . . :
ink cartridge. See Chapter 6 for instructions.

Pause  When the Pause light is on, printing is paused. Press the

Pause button to resume.
When the Pause light flashes, your printer is charging
ink, cleaning the print heads, or performing another
operation. See Chapter 6 for details.

Plain Paper  The Media Type light indicates which media you selected

360 DPI Ink Jet Paper
Photo Quality Ink Jet Paper
Photo Quality Glossy Film
Ink Jet Transparencies
Other/Media Selection Off

with the Media Type button. When you print, the printer
software checks the software setting and this selection to
see if they match. If they do not match, an error message
appears on your screen. If you do not want to use this
feature, select Other/Media Selection Off.

Note:
\ The Media Type setting only works when
printing from the paper tray with
j Windows 95 or Macintosh

If paper is loaded and the Media Type lights flash, the
paper-release lever is not in the correct position. Match the
paper-release lever position with the media type and paper
source you are using.

All the lights

When all the lights flash, your printer may have an
internal error. See Chapter 7 for more information.
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Buttons

Operate O

Turns the printer on and off.

LF/FF

Feeds paper line by line. Loads a single sheet or advances
continuous or banner paper to the next top-of-form position
if held down.

Load/Eject

When paper is not loaded, loads a sheet of paper or a single
sheet of continuous paper.

When paper is loaded, ejects a sheet of paper. Feeds
continuous (tractor-fed) paper backward to the paper-park
position. Ejects banner paper backward. Feeds continuous or
banner paper to the tear-off position when pressed after
printing and Auto tear-off mode is set to off in default-setting
mode.

Pause/Reset

Stops printing temporarily. Resumes printing when pressed
again.

Clears the printer buffer if pressed for five seconds.

Micro Adjust &

Micro Adjust #

Adjusts the loading position or tear-off position for
continuous paper. Press the Micro Adjust # button to feed
paper forward or press Micro Adjust # to feed paper
backward.

Micro Adjust settings are saved in the printer’s memory. See
“Using the Micro Adjust Buttons” on page 3-20 for details
on adjusting the loading position or tear-off position.

Cleaning 6 Starts the black print head cleaning cycle if pressed for
three seconds. See “Cleaning the Print Heads” on page 6-1.

Cleaning & Starts the color print head cleaning cycle if pressed for
three seconds. See “Cleaning the Print Heads” on page 6-1.
Media Type Determines whether the Media Type setting you selected in

the printer driver matches the type of media loaded in the
printer.

Note:
\ The Media Type setting only works when
printing from the paper tray with Windows 95

*"! or Macintosh.




Note:

For instructions on
printing HPGL or HPGL/2
plot files, see Appendix B.

Custom Printing

When you want to print presentation graphics, photographs, or
other special projects, you can use the custom settings in your
EPSON Stylus COLOR 3000 software. You can choose
predefined settings or adjust individual options like brightness,
contrast, saturation, and halftoning. For professional-quality
color accuracy, you can use Image Color Matching (ICM) with
Windows 95 or ColorSync with the Macintosh.

This chapter includes the following information:
»  Using predefined advanced settings

»  Customizing print quality and special effects
»  Customizing color settings

» Using ColorSync on the Macintosh

»  Saving custom settings

Using Predefined Advanced
Settings
Predefined settings provide an easy way to fine-tune your

printer’s operation for special projects. Follow these steps to
print with predefined settings:

1. Create your document, image, or project in your
application software.
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2. Access the Main printer settings dialog box as described on
page 1-2 (Windows) or page 1-10 (Macintosh).

You see one of the following dialog boxes:

Click Advanced, then click here
to see a list of project types

N\
2\

Note:

When you use

Advanced settings, the EFSOM I ’
Quality/Speed slider

disappears. R e .
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Macintosh
Click Advanced then click here
to see a list of project types
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Always choose your Ink
setting before you select a
project setting from the
Customs Settings list.

Selecting Video/Digital
Camera, ICM, or
ColorSync automatically
sets the Ink option to
Color.

If you are printing with
Windows NT 3.51, follow
the steps in the next
section to check an
additional print option
described on page 2-7.

\
Note: j

See Chapter 3 for
information about using
special media.

Custom Printing

3. Select Color or Black Ink.

4. Click Advanced, and then Custom Settings. You see a

list of project types.

Follow these guidelines to choose the right setting for your
project:

» Photo
For printing scanned photographs. Increases contrast
in the image.

» Text/Graph
For printing graphics-intensive documents like
presentation pages with charts and graphs. Intensifies
colors and lightens the midtones and highlights.

» Video/Digital Camera (not available for
Windows NT)
For images captured from a digital camera or video.
Increases color brightness and makes the image sharper.

» Economy
For rough drafts of text only, on plain paper. Saves ink.

» ICM (Windows 95 only)
Automatically adjusts printout colors to closely match
the colors on your screen.

» ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match
the colors on your screen. For more information, see
page 2-10.

Choose the Media Type you want to print on. (If you are
not sure which setting to select, refer to the table on

page 3-3.) The available media are limited by the project
you choose.

Use the Media Type button on the printer’s control panel
to select the media you loaded in the printer and selected in
step 6 (Windows 95 and Macintosh only). If your media
type is not listed on the control panel, select Other/Media
Selection Off.
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\
Note: j

After you customize your
print settings for a special
project, you can save
them as a group. Then
you can reuse them
whenever you print a
similar project. See

page 2-12 for instructions.

8.

Select the correct Paper Source, Paper Size, and other
options for the media and feeder you’re using.

Check the Current Settings box on the bottom of the menu
to see if the other settings are correct for your document.
If they’re correct, click OK or Print. (If you're using
Windows, click any other buttons that your application
uses for printing.)

If the predefined settings are not quite what you want,
follow the steps in the next section to change them.

Customizing Print Quality and
Special Effects
If you need maximum control over your project, or you want to

experiment with special effects, you can adjust individual
settings in your printer software. Follow these steps:

1.

Create your document, image, or project in your
application software.

Access the Main printer settings dialog box as described on
page 1-2 (Windows) or page 1-10 (Macintosh).
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3. Click Advanced, and then click More Settings. You see

Some of these options
are automatically set

or disabled by other —|
settings you choose

Some of these options
are automatically set

or disabled by other —

settings you choose

the More Settings dialog box:
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\
Note: j

The Print Quality is
selected automatically
depending on the current
Media Type. If you choose
a Print Quality setting that
is not appropriate for your
media, the driver changes
the Media Type setting.
Be sure to check both of
these settings to make
sure they are correct for
the media you loaded.

\
Note: j

In Automatic mode, the
Halftoning setting is
selected based on the
data in your print job.

In Advanced mode,
Halftoning is preselected
for each document type
setting. The No Halftoning
option is available only
when you select Black as
the Ink setting.

Choose one of the following Print Quality options:

Economy

For low-resolution rough drafts on plain paper. Saves
ink.

Normal - 360 dpi

For most documents on plain paper, transparencies, or
360 dpi Ink Jet or Banner paper.

Fine - 720 dpi
For high-resolution output. Works best on photo

quality media (including EPSON Photo Quiality
Banner paper), back light film, or canvas cloth.

SuperFine - 1440 dpi
For the highest-resolution output on photo quality
media, back light film, or canvas cloth only.

Choose the Media Type setting you want to use, following
the guidelines on page 3-3.

Press the Media Type button on the printer’s control panel
to select the media you loaded in the printer and selected in
step 5 (Windows 95 and Macintosh only). If your media
type is not listed on the control panel, select Other/Media
Selection Off.

Select Color or Black ink.

Choose one of the following Halftoning options:

No Halftoning
For printing black text only.

Error Diffusion

For printing photographic or video/digital camera
images. Blends each dot of color with the surrounding
dots.

Fine Dithering, Coarse Dithering

For printing charts, graphs, and other images that
require precise, solid areas of bright colors. Arranges
dots in orderly patterns. Use Coarse for images with
more shading and less detail. Use Fine for images with
more detail and less shading.



Lip

If vertical lines in your
printout are misaligned
when you use the High
Speed setting, you may
need to align the print
heads. See Chapter 6 for
instructions.

10.

11.

12.

Custom Printing

Choose any of the following print options. Some of these
settings are automatically selected or disabled by the Print
Quality (resolution) and Media Type settings you chose.

» MicroWeave
For improved print quality. Prints graphic data in finer
increments to eliminate unwanted banding effects
(light horizontal lines). Always use for color printing.

» High Speed
For fast, bidirectional printing at lower quality.

» Flip Horizontal
Prints a mirror image of your document. Use for
printing with iron-on transfer paper or back light film
so the image will appear correctly on your iron-on item
or backlit display.

» Finest Detail
For printing text, graphics, and line art with very sharp
edges. Slows print speed and increases your system
memory requirements.

» Print Using a Temporary File (Windows NT 3.51
only)
For increasing the speed that Windows NT 3.51
returns to your application by printing to a temporary
print file. A separate application then sends the file to
your printer. Turn off this option when printing
complex documents or if parts of a printout are missing
after printing with it turned on.

If you're ready to print, click OK and go to step 11. If you
want to adjust your printer’s color settings, see the next
section.

Click Save Settings if you want to save your custom
settings as a group that you can reuse for special projects.
See page 2-12 for instructions.

Click OK (Windows) or Print (Macintosh). If you're using
Windows, click any other buttons that your application
uses for printing.
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Customizing Color Settings

You can choose from several color adjustment modes or
manually adjust brightness, contrast, saturation, and individual
CMY (cyan, magenta, yellow) colors. To achieve maximum
color accuracy, you can use Image Color Matching (ICM)
under Windows 95 or ColorSync on the Macintosh.

Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on
page 2-4. The color settings appear on the right side of the
dialog box, as shown:

Click to set Color Adjustment Mode

) Do | 8 Color
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(ICM is available only for Windows 95)
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2. Choose one of the following Color Adjustment Modes or
choose another mode, as described in step 4:

Automatic
Analyzes the color information in your project and
optimizes color correction accordingly.

Photo-realistic

For printing color photographs.

Vivid

For printing graphics-intensive documents like

presentation pages with charts and graphs. Intensifies
colors and lightens the midtones and highlights.

No Color Adjustment (Windows NT 4.0 and
Macintosh only)

With Windows NT 4.0, disables the color adjustment
features of the printer software so you can adjust colors
using your application. On a Macintosh, choose this
mode only if you’re using ColorSync.

If you want to change individual color characteristics, use

the scroll bars to increase (drag right) or decrease (drag left)
the settings listed below. (If you use one of the options
described in step 4, you won't be able to specify individual
color characteristics.)

Brightness
Makes your image lighter or darker.

Contrast
Increases or decreases the difference between the bright
or dark parts of an image.

Saturation
Makes colors more vivid or less vivid.

Cyan, Magenta, Yellow

Increases or decreases the amount of the three ink
colors that combine to make a full-color picture. Use to
fine-tune the color balance in your printout.
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\
Note: j

When you choose
Video/Digital Camera,
ICM, or ColorSync,

the individual color
characteristics described
in step 3 are preset.

The availability of ICM
depends on your Print
Quality, Media Type, and
Halftoning settings.

4. To fine-tune color correction for video/digital images or to
closely match screen colors, choose one of these modes
instead of a Color Adjustment Mode:

» Video/Digital Camera (not available for
Windows NT)
Use for printing images captured from a digital camera
or video. Increases contrast and saturation and makes
the image sharper.

» ICM (Windows 95 only)
Automatically adjusts printout colors to closely match
colors on the screen.

» ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match
colors on the screen. See “Using ColorSync on the
Macintosh” below for instructions.

5. Click OK to return to the Main printer settings dialog box.

6. Click Save Settings if you want to save your custom
settings as a group that you can reuse for special projects.
See page 2-12 for instructions.

7. Click OK (Windows) or Print (Macintosh). If you’re using
Windows, click any other buttons that your application
uses for printing.

Using ColorSync on the Macintosh

Every device you use for viewing or producing colors—your
monitor, scanner, and printer—uses a different color
technology. That’s why it’s difficult to get printed colors to
match the colors displayed on your monitor.

Each device has its own gamut, or range of colors, that it can
reproduce. The Macintosh ColorSync system translates colors
from one gamut to another so your monitor’s colors match your
printer’s colors as closely as possible.
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The EPSON Standard
profile is custom-
designed for your printer.
If you use a scanner or
other color imaging
equipment, you may have
other profiles available.

The Saturation and
Colorimetric options are
only available when
you’re using Fine - 720 dpi
or SuperFine - 1440 dpi
Print Quality.

Custom Printing

ColorSync uses profile information from each device—
including your EPSON Stylus COLOR 3000—to achieve
accurate color matching. First you set your monitor’s profile.
Then you can use your printer software to specify the exact
method of “gamut mapping” (color matching) you want to use.
Follow these steps:

1. Click ColorSync System Profile under Control Panels
on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.
4. Close ColorSync System Profile.

5. Open the application you want to print from.

6. Access the printing dialog box as described on page 1-10.
Click Advanced and then click More Settings.

7. Click ColorSync on the right side of the dialog box.
8. For Profile, choose EPSON Standard.

9. Choose one of the following options for Rendering Intent:

» Perceptual
For printing photographs. Adjusts the colors displayed
on the monitor so they fit within the printer’s gamut,
but maintains the relationships between colors.

» Saturation
For printing graphics-intensive documents like
presentation pages with charts and graphs. Maintains
the relative saturation of colors from one gamut to
another.

» Colorimetric
For matching colors as precisely as possible. Maintains
colors that fall within the gamuts of the monitor and
printer, but may lose some detail where the colors are
outside the printer’s density range.

10. Click OK, and then click Print.
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Note: j

You can save up to
10 groups of settings.

If you change the Media
Type or Ink setting when
your customized setting
is selected, the setting
selected in the list
changes to Custom
Settings. To return to
your customized setting,
reselect it in the list. To
redefine a customized
setting, see page 2-13.

Saving Custom Settings

After you've fine-tuned your printer settings for a special
project, you can save your settings as a group with a unique
name and add it to the Custom Settings list on the Main menu.
Then you can easily select the settings the next time you print a
similar project. Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the Main printer
settings dialog box. (If Save Settings is grayed out, click
Advanced)

You see one of the following:

Windows

Ciralam Seltin gk Rams I. Cancel I

Macintosh

3. Type a unique name for your settings (up to 16 characters)
and click the Save button.

The name you choose is now available on the Main printer
settings dialog box when you click Advanced, and then
Custom Settings.
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Deleting Custom Settings

If you no longer need a customized setting, follow these steps to

delete it:

1. Select Advanced mode.

2. Click Save Settings.

3. Select the name of your custom setting group in the

Custom Settings box, and click Delete. (You cannot delete
any of the predefined document types.)

Redefining Custom Settings

To change the options in a customized setting group but keep
the same name for it, follow these steps:

1.

2.

Select Advanced mode.

Select the name of the custom setting group you want to
redefine in the Custom Settings list.

Change the printer settings as necessary. (If you change the
Media Type and Ink settings, the custom setting group
name reverts to Custom Settings; this doesn’t affect your
customized setting.)

Click Save Settings.

Select the name of the custom setting group you're
redefining in the Custom Settings box.

If you're using Windows, click Save. You see the Save As
dialog box. Click OK to save your redefined settings. (Click
Cancel to cancel your changes.)

On a Macintosh, click the Redefine button. Then click
Replace at the confirmation dialog box to save your
redefined settings. (Click Cancel to cancel your changes.)
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Your EPSON Stylus COLOR 3000 lets you print on just about
any kind of paper you want to use. You can get great results
printing on plain paper, letterhead, and envelopes. But you’ll
get the best results with EPSON'’s specially coated ink jet paper.
You can choose from a variety of EPSON media, ranging from
glossy paper and transparencies to iron-on transfer paper and
canvas cloth.

Your printer’s versatile feeding options let you load media of
almost any size or format, including single sheets, continuous
paper, and roll paper for banners and signs. You can even load
two types of paper at once, switching between them with the
flip of the paper-release lever when you’re ready to print on
them.

This chapter covers the following:

»  Using special media

»  Printing on single sheets

»  Printing on continuous paper

»  Adjusting the loading and tear-off positions

»  Switching between continuous and single-sheet paper
»  Printing a banner or other roll paper project

» Printing a backlit display
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Using Special Media Types

The type of paper or other media you use is one of the most
important factors in determining the quality of your printed
output. You can use most plain paper with your printer and
achieve good results. For better results, use EPSON specially
coated ink jet paper because it provides the best surface for the
ink used in your printer. EPSON offers specially designed media
for EPSON ink jet printers in a variety of sizes.

To order EPSON papers and other media, contact your dealer
or call EPSON Accessories at (800) 873-7766 (U.S. sales only).
In Canada, please call (800) 873-7766 for dealer referral.

Media name Size Part number
EPSON 360 dpi Ink Jet Paper Letter S041060
Ad S041059
Super A3/B S041066
EPSON High Quality Ink Jet Paper Letter S041111
Ad S041117
EPSON Photo Quality Ink Jet Paper Letter S041062
Ad S041061
Legal S041067, S041048
B S041070
Super A3/B S041069
A2 S041079
EPSON Photo Quality Glossy Paper A4 S041126
Letter S041124
A2 S041123
Super A3/B S041133
EPSON Photo Quality Glossy Film A4 S041071
Letter S041072
A6 S041107
B S041075
Super A3/B S041074
EPSON Ink Jet Transparencies Ad S041063
Letter S041064
EPSON Photo Quality Ink Jet Cards A6 S041054
8 x10 S041122
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Media name Size Part number
EPSON Iron-On Transfer Paper Letter SE41001, SE41002
Super A3/B SE41003
EPSON Photo Quality Self Adhesive Sheets | A4 S041106
EPSON Photo Quality Banner Paper A2 x 15 m roll S041102
(16.5 inches x 49.2 ft)
EPSON Ink Jet Canvas Cloth A2 x 3 mroll S041132
(16.5 inches x 9.8 ft)
EPSON Ink Jet Back Light Film A2 S041130
A3 S041131

Media Loading and Software Settings
Guidelines

Whether you print on plain paper or special media, you need to
load it according to the guidelines in the table below. You must

also be sure to select the correct Media Type setting in your
printer software and on the printer’s control panel
(Windows 95 and Macintosh only) to match the media you
loaded. See page 3-5 for additional guidelines..

When you load media with this
name. ..

Load a maximum of this
many sheets in the built-in
sheet feeder as described on
page 3-7 . ..

Then select this Media
Type setting in your
printer software . . .

Plain paper (single sheets)

100 letter size
30 Super A3/B size
30 A2 size

Plain paper (continuous paper)

(See “Printing on Continuous
Paper” on page 3-15.)

Envelopes (remember to set the
thickness lever forvvard)1

10

Labels (single sheets)

(See “Loading Paper in the
Manual Feeder” on page 3-12.)

Continuous label paper

(See “Printing on Continuous
Paper” on page 3-15.)

Plain paper
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When you load media with this
name . ..

Load a maximum of this
many sheets in the built-in
sheet feeder as described on
page 3-7 . ..

Then select this Media
Type setting in your
printer software . . .

EPSON 360 dpi Ink Jet Paper

EPSON Special Coated Paper for
360 dpi Printing

70 letter size

30 legal size

30 Super A3/B size
30 A2 size

360 dpi Ink Jet Paper

EPSON High Quality Ink Jet Paper

70 letter size

. 30 legal size
EPSON Photo Quality Ink Jet 30 Super A3/B
aper 30 A2 size
EPSON Special Coated Paper for
720 dpi Printing
EPSON Photo Quality Ink Jet 30 cards?!

Cards

EPSON 720 dpi Index Cards

EPSON Photo Quality Self
Adhesive Sheets

(See “Loading Paper in the
Manual Feeder” on page 3-12.)

EPSON Photo Quality Banner
Paper

(See ““Loading Roll Paper” on
page 3-24.)

Photo Quality Ink Jet Paper

EPSON Photo Quality Glossy
Paper (use with support sheet)

20 letter size

Photo Quality Glossy Paper

EPSON Photo Quality Glossy Film
(use with support sheet)

30 letter size
1 A2 size

EPSON High Quality Glossy Paper
(use with support sheet)

30 letter size
1 A2 size

EPSON Iron-On Transfer Paper2

1 sheet

Photo Quality Glossy Film

EPSON Ink Jet Transparencies
(use with support sheet)

30 letter size

Ink Jet Transparencies

EPSON Ink Jet Back Light Film

1 sheet

Ink Jet Back Light Film

EPSON Ink Jet Canvas Cloth

(See “Loading Roll Paper” on
page 3-24.)

Ink Jet Canvas Cloth

1 Load with the short edge leading into the feeder. Remember to set the thickness lever forward.

2 Use the Flip Horizontal option to reverse your image before you print it—especially if it includes
text—so the image will appear correctly when it’s transferred. See Chapter 2 for instructions.
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Additional Media Loading Guidelines

If the corresponding Media Type option for your paper is
not shown in the Media Type list, change the Print
Quiality setting in the More Settings dialog box, select
Automatic as the Mode setting, or change the predefined
setting in the Custom Settings list on the Main menu. See
Chapter 2 for more information.

In addition to the Media Type option, remember to select
the correct Paper Size for your media.

Some special media have a cut corner that you need to
position correctly; follow any instructions in the package.
Always handle sheets by the edges, and don’t touch the
printable surface.

If the special media has protective sheets between each sheet
of media, be sure to remove the protective sheets before
printing.

Be sure to load the printable side of the media in the correct
direction for the feeder you’re using. When you’re loading
pre-printed paper, such as letterhead or forms, position the
paper as follows:

» Load it with the top edge leading into the printer

»  Place the printable side:
Down in the sheet feeder
Up in the manual feeder, on the built-in tractor feeder,
or on the roll paper feeder

Use ink jet papers within one year of purchase. Use glossy
media and transparencies within six months. Return
unused sheets and envelopes to their original packages as
soon as possible. See Appendix C for more media storage
information.

Some EPSON media include a cleaning sheet. After you
finish printing a package of EPSON media, use the cleaning
sheet included with the media. See the instructions on the
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cleaning sheet for more information. Be sure to load the
cleaning sheet in the paper tray with the cut corner
positioned as shown below:

cut corner

»  See the following sections for complete media loading
instructions:

»  See page 3-7 for paper tray (built-in sheet feeder)
instructions

»  See page 3-12 for manual feeder instructions
»  See page 3-15 for continuous paper instructions.

»  See page 3-24 for banner paper instructions.

Printing on Single Sheets

You can print on single sheets of paper up to 17 inches wide
(432 mm) in your printer using the paper tray (built-in sheet
feeder) or the manual feeder.

You'll probably use the paper tray at the front of your printer
for the paper size you use most often. Then you can use the
manual feeder at the top of the printer for loading individual,
large format sheets or roll paper held in the roll paper holder.
(See page 3-23 for more information on the roll paper holder.)

Follow the instructions in the sections below to load single
sheets of paper from these feeders.



N\
il

Note:

The maximum printable
width is 16.3 inches
(416 mm) on any size

paper.
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Loading Paper in the Paper Tray

You can load any type of paper up to 17 inches wide (432 mm)
in the paper tray, but do not load the stack above the arrow
mark on the right edge guide. If you load paper more than
14.3 inches (364 mm) wide, load a maximum of 30 sheets at a
time, regardless of the paper type. Always load paper before you
send a print job.

1. Turn on the printer.

2. Move the paper-release lever backward to the single sheet
position.

3. Set the thickness lever backward to the 0 position for plain
paper, ink jet paper, transparencies, transfer paper, and
labels.

Set the thickness lever forward to the + position for
envelopes, ink jet cards, and heavy paper.
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4. Open the printer hood and remove the paper tray cover.

5. If you’ll be printing on paper that is 16.5 inches (420 mm)

wide or less, slide the right edge guide all the way left until
it clicks into place.

If the paper is more than 16.5 inches (420 mm) wide, slide
the right edge guide all the way right.
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6. Slide the left edge guide to match the approximate width of
your paper. Then move the center support midway
between the two edge guides.

center
support

left edge
guide

7. If you are printing on paper longer than A4 (11.75 inches),
fold down the rear edge guide and pull out the paper tray
extension (the paper tray extension acts as the rear edge

guide.)

paper tray
extension

8. Fan your stack of paper and then even the edges.
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9. Load the stack with the printable side face down and slide
it all the way into the feeder. Gently press the stack against
the right edge guide.

If you are loading envelopes, place the envelopes face down
with the flap edge leading into the feeder. You can load a
maximum of 10 envelopes.
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If you are loading ink jet cards, place the cards face down
with the short edge leading into the printer.

10. Slide the left edge guide against the left side of the paper.

11. Slide in the rear edge guide or paper tray extension to
match the length of your paper.

12. Replace the paper tray cover and close the printer hood.

If you've loaded paper longer than A4 (11.75 inches), pull
out and unfold the paper tray cover extension to match the
length of the paper tray.
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13. Now follow the instructions in Chapters 1 or 2 to select the

\ correct Paper Source, Paper Size, and other settings in
your printer software. Then send a print job.
— l » If the printer runs out of paper during a print job,
Note- reload the paper tray and press the Pause button to
Make sure that paper continue printing.
isn’t loaded in the manual »  If the ink smears on your document, set the thickness

feeder at the top of the
printer before sending
your print job. If paper is
loaded in the manual
feeder, the printer will

lever to the + position and reprint; see page 3-7.

» If your margins are not where you like them, adjust
them in your application software. However, if the

print on it instead of the problem seems to be with your paper’s loading
paper in the built-in sheet position, you can change it using the Micro Adjust
feeder. buttons; see page 3-20 for instructions.

Loading Paper in the Manual Feeder

You can load one single sheet of paper in the manual feeder
without removing paper from the paper tray. Load any type of
paper that is between 4.1 inches (105 mm) and 17 inches

(432 mm) wide. Always load paper before you send a print job.

1. Turn on the printer.

\ 2. Move the paper-release lever backward to the single sheet
position.

=\ g

Note:
To load banner paper, N\
canvas cloth, or other

roll paper in the manual
feeder, you must use
the roll paper holder. See
page 3-23 for
instructions.

\ 2 \\\
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Note:

The maximum printable
width is 16.3 inches
(416 mm) on any size

paper.
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Set the thickness lever backward to the O position for plain
paper, ink jet paper, transparencies, transfer paper, and
labels.

Set the thickness lever forward to the + position for
envelopes, ink jet cards, and heavy paper.

If any paper is currently loaded in the paper path from the
paper tray or the tractor feeder, press the Load/Eject
button to eject the paper or park it out of the way.

If you'll be printing on paper that is 14.3 inches (364 mm)
wide or less, slide the right edge guide on the manual feeder
so its right edge aligns with the arrow mark on the manual
feed guide.

If the paper is more than 14.3 inches (364 mm) wide, slide
the right edge guide all the way right.
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6. Slide the left edge guide to the approximate width of your
paper.

7. Load the paper with the printable side face up and its right
edge against the right edge guide. Then gently slide it into
the manual feeder until the printer pulls it in.

You can load one envelope in the manual feeder face up
with the flap edge leading into the feeder. Gently slide the
envelope into the manual feeder until the printer pulls it in.

If the paper doesn’t load straight, press the Load/Eject
button on the printer’s control panel to eject the paper;
then load it again.



\
Note: j

Make sure that paper
isn’t loaded from the
paper tray before sending
a print job for paper in the
manual feeder. If paper is
loaded from the paper
tray, the printer will print
on it instead of the paper
in the manual sheet
feeder.

Lip

When you print on
continuous paper, itis a
good idea to turn on auto
tear-off mode so the
printer paper can advance
to the tear-off position
automatically. Follow the
instructions on page 5-3.

\
Note: j

The maximum printable
width is 15 inches
(381 mm) on continuous

paper.
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8. Now follow the instructions in Chapters 1 or 2 to select the
correct Paper Source, Paper Size, and other settings in
your printer software. Then send a one-page print job.

» If the ink smears on your document, set the thickness
lever to the + position and reprint; see page 3-13.

» If your top and bottom margins are not where you like
them, adjust them in your application software.
However, if the problem seems to be with your paper’s
loading position, you can change it using the Micro
Adjust buttons; see page 3-20 for instructions.

To print another document in the manual feeder, load the
paper as described above. To switch back to printing from the
paper tray, press the Pause button to turn off the Pause light.
Then send another print job.

Printing on Continuous Paper

You can load continuous paper in the built-in tractor feeder on
the back of the printer without removing paper from the paper
tray. Load any type of continuous paper that is between

4 inches (102 mm) and 16 inches (406 mm) wide, such as
greenbar computer paper, fanfold banner paper, or continuous
label paper. Always load paper before you send a print job.

1. Turn on the printer.

2. Set up your printer so there’s enough room in the back to
feed the paper and enough room in front for the printed
pages to stack without obstruction. Position the paper
supply within 3 feet (1 meter) of the printer.
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3. Move the paper-release lever forward to the continuous
— O - paper position.

Jale;

O =

/

Caution: N} &
If you load continuous N
/

label paper, make sure
the printer’s auto tear-off
feature is turned off. If
you have this feature
turned on, labels could
be fed backward and
peel off inside the
printer. See page 5-3 for
instructions on changing
the auto tear-off setting
using default-setting
mode.
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6. Pull up the blue sprocket-lock levers to unlock them so you
can slide the sprockets into position.

7. Slide the left sprocket all the way right until it stops. Press
down the sprocket-lock lever to lock it in place.

8. Slide the right sprocket to the approximate width of your
paper. Then position the center support midway between
the two sprockets, as shown in the previous illustration.

9. Flip open both sprocket covers.
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\
Note: j

If you run out of
continuous paper while

printing, the Paper Out [/

and Pause lights come
on. Load more paper on
the tractor feeder and
press the Pause button
to continue printing.

10. Arrange the continuous paper stack so the printable side is
face up. Fit the first four holes over the sprocket pins on
both sprockets; then close the sprocket covers.

11. Slide the right sprocket to remove any slack in the paper.
Then press down the sprocket-lock lever to lock it in place.
If necessary, align your stack of continuous paper so it will
feed straight into the tractor feeder.

12. Reinstall the manual feeder on the top of the printer.

13. Make sure the edge of the paper tray is beneath the paper
tray cover so the continuous paper does not catch on it as it
gjects.
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Caution:

If you need to adjust the
loading position, see
page 3-21. Never use the
knob on the left side of
the printer to adjust the
loading or tear-off
positions. This would
damage your printer and
cause it to lose the
top-of-form position.

\
Note: j

See Chapter 5 for
information on using
default-setting mode to
change the auto tear-off
setting for your print job.
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14. Follow the instructions in Chapters 1 or 2 as necessary to

send a print job. Be sure to select Tractor Feeder as the
Paper Source option and then choose the correct Paper
Size. The continuous paper loads and printing begins
when the printer receives the print job.

Follow the steps in the next section to remove continuous paper
correctly.

Removing Continuous Paper

When you've finished printing a continuous paper document,
you must carefully follow these steps to remove it from the
printer, depending on your media type and the setting of the
auto tear-off feature.

1.

If the printer’s auto tear-off feature is turned on, your
continuous paper is automatically advanced to the tear-off
position at the end of a print job. Go to step 2.

If the auto tear-off feature is turned off (the default setting),
press the LF/FF button as many times as necessary to
advance the last printed sheet to the tear-off edge. Go to
step 2.

If the auto tear-off feature is turned off (the default setting),
and you're printing labels, tear off the next sheet of labels at
the back of the printer. Then press the LF/FF button on the
printer’s control panel as many times as necessary to eject
the remaining pages from the printer. Do not perform
steps 2 and 3.
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2. Lift the printer hood and tear off the printed pages at the
perforation by pulling it across the tear-off edge.

~ O - If the paper’s perforation was not at the printer’s tear-off

P O edge, adjust the tear-off position as described on page 3-22.
O Do not perform step 3.

Caution:

Never press Load/Eject 3. Press the Load/Eject button to feed the rest of the

when you have continuous paper backward to the paper-park position so
continuous label paper it'’s ready for printing the next time you need it.

loaded in the printer.

This would feed labels If the ink smears on your document, you can set the thickness
backward, causing lever to the + position and reprint; see page 3-13

them to peel off inside P print, Pag '

the printer.

If your margins are not where you want them, adjust them in
your application software. However, if you need to adjust your
paper’s loading position, you can change it using the Micro
Adjust buttons. See the next section for instructions.

Using the Micro Adjust Buttons

The Micro Adjust # and Micro Adjust 8 buttons on your
printer’s control panel allow you to make quick adjustments to
your paper’s loading and tear-off positions.
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Caution:

Never use the knob on
the left side of the printer
to adjust the loading or
tear-off positions. This
would damage your
printer and cause it to
lose the top-of-form
position.
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Adjust the paper’s loading position if you notice that printing is
too high or low on the page and the position cannot be
corrected in your software program. You can even set separate
loading positions for continuous paper, manually fed paper, or
paper tray fed paper. The settings you make remain in effect
until you change them again, even when you turn off the
printer.

If you're using continuous paper and the perforation does not
align with the printer’s tear-off edge when you're done printing,
you can use these buttons to adjust the tear-off position.

Adjusting the Loading Position
Follow these steps to adjust the loading position of your paper:

1. Ifyou have continuous and single sheet paper loaded at the
same time, the loading position you adjust is determined by
the setting of the paper-release lever.

For continuous paper, set the paper-release lever backward
to the continuous paper position.

For paper in the sheet feeder or the manual feeder, set it
forward to the single sheet position.

2. Press the Load/Eject button to load a sheet of paper or load
the first continuous sheet to the top-of-form position.

3. Press the Micro Adjust # button to feed paper backward
or the Micro Adjust # button to feed paper forward. Press
either button as many times as necessary to adjust the
position. When the adjustment reaches the maximum
setting for your printer, it does not move further.

4. Follow the instructions in Chapters 1 or 2 as necessary to
send a print job.

The loading position you select remains in effect until you
change it again, even when you turn off the printer.
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\O/
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Caution:

Never adjust the tear-off
position when you’re
printing labels. This could
feed labels backward,
causing them to tear off
inside the printer.

Adjusting the Tear-off Position

First make sure that continuous paper is loaded and parked in
the current tear-off position (see page 3-19 for details). Follow
these steps to adjust the tear-off position:

1. Press the Micro Adjust # button to feed paper backward
or the Micro Adjust # button to feed paper forward. Press
either button as many times as necessary to align the
perforation with the tear-off edge. When the adjustment
reaches the maximum setting for your printer, it does not
move further.

2. Tear off any printed pages.

3. Press the Load/Eject button to feed the rest of the
continuous paper backward to the paper-park position so
it's ready for printing the next time you need it.

The tear-off position you select remains in effect until you
change it again, even when you turn off the printer.

For instructions on setting your printer’s auto tear-off mode, see
Chapter 5.

Switching Between Continuous
and Single Sheet Paper

When you have both continuous paper and single sheet paper
loaded in the paper tray, you can switch between paper types
whenever you need to print on them. Follow these steps:

1. If continuous paper remains inside the printer, tear off the
printed pages. Then press the Load/Eject button on the
printer’s control panel to feed the paper backward to the
paper-park position.

If single sheet paper is loaded, press the Load/Eject button
to eject any sheets still inside the printer.



\
Note: j

If the Pause and Paper
Out I lights flash, you
may have changed the
paper-release lever
position when paper
was still loaded. Set the
lever back to its original
position and press the
Load/Eject button to
eject or park the paper.
Then set the lever to its
new position.
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2. To switch to single sheet printing, move the paper-release
lever backward to the single sheet position.

To switch to continuous paper printing, move the
paper-release lever forward to the continuous paper
position.

3. Now follow the instructions in Chapters 1 or 2 to select the
correct Paper Source, Paper Size, and other settings in
your printer software. Then send a print job. The printer
loads the type of paper you selected when it receives the
print job.

Printing a Banner or Other Roll
Paper Project

You can use EPSON banner paper or canvas cloth to print a
banner up to 44 inches long. EPSON Ink Jet Canvas Cloth has
cloth-like texture—much like artist’s canvas for painting—that
gives a distinct look to your printed images.

First follow the instructions below to load the banner paper or
canvas cloth from a roll. (You can also print a banner on
continuous computer paper. See page 3-15 for paper loading
instructions.) Then see the appropriate printing instructions for
your software—Windows or Macintosh—in the sections that
follow.

For best results and a more professional looking banner, the
optional banner paper cutter (C815052) is recommended.
Contact your dealer or call EPSON Accessories at

(800) 873-7766 (U.S. sales only). In Canada, please call
(800 873-7766 for dealer referral.
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Loading Roll Paper

O 1. Before you load roll paper, follow the instructions on
~ - page 5-3 to set up the printer for banner printer using
P O default-setting mode. Select these options:

O » Turn banner mode on so the printer doesn’t advance

Caution: all the roll paper out of the printer if you press the
Do not insert paper before LF/FF button

you turn on the printer.
» Turn auto tear-off mode on so the printer can advance
the roll paper to the correct cut-off position.

When you've finished setting these options, turn off the
printer to exit default-setting mode, wait 5 seconds, then
turn on the printer before continuing with step 2.

2. Move the paper-release lever backward to the single sheet
position.
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4. Open the banner paper cover.

5. Slide both edge guides as far away from the center as they
can go.

6. Position the banner paper roll so that the paper feeds into
the printer from the top of the roll (the printable side is
face up).

Place the banner paper roll on the right roll paper holder.
Then slide the left banner paper holder to match the roll’s
width. Make sure the holders are snug against the banner
paper roll, but do the squeeze the paper too tightly;
otherwise the roll will not rotate properly.
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7. Make sure the roll paper is tightly wound on the roll. While
holding both ends of the roll, slowly feed the paper into the
manual feed slot until it meets resistance. The printer
automatically feeds the paper to the loading position. (If
the paper is crooked, press the Load/Eject button to
backfeed the paper and try loading it again.)

8. Follow the instructions below to print your banner on
either a Windows computer or a Macintosh.

Printing a Banner from Windows

Follow these steps to print a banner or other custom-size project
on a Windows computer:

1. Create the document in your word processor or other
application software. You can create a banner in either
portrait or landscape orientation.

2. Choose Print or Print Setup from the File menu. You see a
printing dialog box for your application.

3. Make sure your printer is selected, and then click the
Printer, Setup, Properties, or Options button. (You may
have to click a series of these buttons, depending on your
software.) You see the Main printer settings dialog box, as
shown on page 1-2.



\
Note: j

Your software application
may allow you to print

a banner longer than

44 inches. See your
software documentation
for details.

4.

5.
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Click the Paper tab. You see a dialog box like the
following:

L5 1M 5 iphax COLON 3000
| Click to select a
paper size

Click to select a
paper source

[T | cowed | o | v |

If you’re printing on roll paper, select Manual Feed

Slot (Banner) from the Paper Source list. At the end of the
Paper Size list, select one Long Paper 17 x n options,
where n is the length of your banner (up to 44 inches). If
your paper size is not in the list, go to step 6; otherwise,
continue with step 7.

If you're printing a banner on continuous computer paper,
select Tractor Feeder for the Paper Source. At the end of
the Paper Size list, select one of the Fanfold nn x nin.
options, where nn is the width of your paper and n is the
length of your banner. If your paper size is not in the list,
go to step 6; otherwise, continue with step 7.
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\
Note: j

With Windows NT, the
User Defined Paper Size
dialog box includes
settings for units of
measure, naming of the
paper size (up to 16
characters), and saving of
multiple user defined
paper sizes. For
instructions on using
these settings, click the
Help button at the bottom
of the Paper dialog box.

6.

10.

At the end of the Paper Size list, choose User Defined. The
following dialog box appears:

B\ Dafined Fapor sieo |
Fapsr Wit [Fm ke
P gt 1 = For banner printing, type
any size up to 44 inches
[ ok ] | cows |

Type in your paper’s width in the Paper Width field

and a length up to 44 inches for the Paper Height. (This
works for banners in either landscape or portrait
orientation.) Click OK. Go to step 7.

Choose Portrait or Landscape if you haven't already
specified the orientation in your application software. Set
the printable area if necessary.

Click the Main tab to return to the Main printer settings
dialog box.

Choose the Media Type setting that matches your banner
paper or canvas cloth as described in the table on page 3-3.
(For continuous computer paper, choose Plain Paper.)

Check the rest of the printer software settings as described
in Chapters 1 and 2. Then click OK.

Click Close, OK, or Print to print your banner. (You may
need to click a series of these buttons, depending on your
software.)
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The printer saves the cut
off (or tear off) position
and it remains in effect
until you change it again,
even after turning off the
printer.
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11. When your print job finishes printing, the printer feeds the
paper to the default cut off (or tear off) position (as long as
the auto tear-off feature is on in default-setting mode). If
necessary, press the Micro Adjust buttons to move the
paper forward or backward to the cut off position.

12. If you are using the optional Banner Paper Cutter, follow
the instructions on page 3-32. Otherwise, use scissors to cut
the paper.

To remove continuous paper, see page 3-19.

If you want to print another roll paper project, the printer feeds
the roll paper back to the loading position when it receives a
new print job.

If you won’t be using your roll paper for awhile, store it in its
original packaging. See Appendix C for optimum storage
conditions.

Before printing on another type of paper, be sure to change the
Paper Source, Paper Size, and Media Type settings in your
printer software as described in Chapters 1 and 2.

Also be sure to turn off banner mode using the default-setting
mode instructions on page 5-3.
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Printing a Banner from a Macintosh

Follow these steps to print a banner or other custom-size project
on a Macintosh:

1. Create the document in your word processor or other
application software. You can create a banner in either
portrait or landscape orientation.

2. Choose Page Setup from the File menu. You see a dialog
box like the following:

Click to select your Click to select

paper size yOl|JI’ paper source
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Click to define a
custom paper size

3. If you're printing on roll paper, select Manual Feed
Slot(Banner) from the Paper Source list.

LS
Z L ;U If you're printing a banner on continuous computer paper,
select Tractor Feeder for the Paper Source.

You can create up to eight 4. Click the Customize button.The following dialog box

custom paper sizes. Give appears:
each one a unique name

so you'll be able to reuse e
them by selecting them m—'-'i-"-'—"'-'-'-'-'-'r‘mn—-ﬁ-'—
from the Page Size list in i el arw Paper iz |_C50
the Page Setup dialog 1 [omiire | ]
box.

Click to

createanew__| e T

paper size [Coe ] (oo

5. Click the New button.
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Your software application
may allow you to print a
banner longer than 44
inches. See your
software documentation
for details.

\
Note: j

The printer saves the cut
off (or tear off) position
and it remains in effect
until you change it again,
even after turning off the
printer.

10.

11.

12.

13.
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Type a name for your custom size in the New Paper Size
box. Then type your paper’s width in the Width field and a
length of up to 44 inches for the Height. (This works for
banners in either “landscape” or “portrait” orientation.)
Click OK.

Choose Portrait or Landscape, depending on the
orientation of the banner or document you created. Set the
printable area if necessary.

Click OK.

Choose Print from the File menu or click the print icon in
your application. You see a printer settings dialog box (as
shown on page 1-10).

Choose the Media Type setting that matches your banner
paper or canvas cloth as described in the table on page 3-3.
(For continuous computer paper, choose Plain Paper.)

Check the rest of the printer software settings as described
in Chapters 1 and 2. Then click Print to print your banner.

When your print job finishes printing, the printer feeds the
paper to the default cut off (or tear off) position (as long as
the auto tear-off feature is on in default-setting mode). If
necessary, press the Micro Adjust buttons to move the
paper forward or backward to the cut off position.

If you are using the optional Banner Paper Cutter, follow
the instructions on in the following section. Otherwise, use
scissors to cut the paper.

To remove continuous paper, see page 3-19.

If you want to print another roll paper project, the printer feeds
the roll paper back to the loading position when it receives a
new print job.

If you won’t be using your roll paper for awhile, store it in its
original packaging. See Appendix C for optimum storage
conditions.
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If you purchased the
optional banner paper
cutter, see its
documentation for
installation instructions.

The roll paper cut-off
position you set remains
in effect until you change
it again, even when you
turn off the printer.

Before printing on another type of paper, be sure to change the
Paper Source, Paper Size, and Media Type settings in your
printer software as described in Chapters 1 and 2.

Also be sure to turn off banner mode using the default-setting
mode instructions on page 5-3.

Removing a Printed Banner

Follow these steps to remove a printed banner using the
optional banner paper cutter:

1.

If you turned auto tear-off mode on (as instructed in step 1
on page 3-24), the printer automatically feeds the paper to
the tear-off position when it’s finished printing. If you
didn’t turn on auto tear-off mode, press the LF/FF button
to advance the paper to the cut-off position.

Press Micro Adjust 8 and Micro Adjust # buttons as
necessary to move the end of the banner to the edge of the
banner paper cutting guide.

Insert the left edge of the paper into the slot on the cutting
unit.

Slowly slide the cutting unit all the way to the right while
lifting up slightly on the left edge of the paper. If you slide
the cutting unit too quickly, apply uneven pressure, or pull
on the paper, your banner will have an uneven, rippled
edge instead of a smooth one.

Slide the cutting unit all the way to the left. Otherwise, the
next time you print, you may get a paper jam.

If you want to print another roll paper project, the printer
will feed the roll paper back to the loading position when it
receives a new print job. Go to step 10.

If you won’t be using the roll paper again right away,
continue with step 6.
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You don’t need to
remove the banner paper
cutter when printing on
other media. Simply slide
it all the way to the left
when you’re finished
cutting with it.

If you need to remove
the banner paper cutter,
see its documentation
for removal instructions.
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6. Press the Load/Eject button to eject the paper backward.

7. Using your hands, roll back the paper all the way out of the
manual feed slot and onto the roll. When it’s completely
out, the Pause and Paper Out . lights turn on.

8. Press the Pause button to turn off the lights.

9. If you won't be using your roll paper for awhile, store it in
its original packaging. See Appendix C for optimum
storage conditions.

10. Before printing on another type of paper, be sure to change
the Paper Source, Paper Size, and Media Type settings
in your printer software as described in Chapters 1 and 2.

Also be sure to turn off banner mode using the
default-setting mode instructions on page 5-3.

If you’ll be printing on continuous paper, also be sure to
reset the paper-release lever, as described on page 3-16.

Printing a Backlit Display

You can use EPSON Ink Jet Back Light Film to print crisp,
translucent images for backlit display. Your printer software
automatically makes a mirror image of your design so it appears
correctly when viewed from the reverse side. Follow the steps in
this section to load a sheet of back light film and select the
correct printer settings for a backlit display.

Loading Back Light Film

Before loading the back light film, make sure the sheet is flat. If
the film curls, place it between two sheets of paper and put a
heavy object on top to flatten it.
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You can load one sheet of back light film at a time as follows:

Load it in the paper tray with the printable, non-glossy,
white surface face down following the instructions on
page 3-7.

Load it in the manual feeder with the printable, non-glossy,
white surface face up following the instructions on
page 3-12.

Printing a Backlit Display from Windows

1. Create the document in your word processor or other

application software.

Choose Print or Print Setup from the File menu. You see a
printing dialog box for your application.

Make sure your printer is selected, and then click the
Printer, Setup, Properties, or Options button. (You may
have to click a series of these buttons, depending on your
software.) You see the Main printer settings dialog box.
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4. Select Ink Jet Back Light Film as the Media Type setting.
This chooses the best printer driver settings for printing on
back light film and automatically turns on the Flip
Horizontal feature so your image will appear correctly
when viewed from the reverse side.

5. Check the rest of the printer software settings available on
the Main menu as described in Chapters 1 and 2.

6. Click the Paper tab.

7. Choose the Paper Source you're using, either Auto Sheet
Feeder (for the paper tray) or Manual Feed Slot (for the
manual feeder).

8. Then select the size of your back light film as the
Paper Size setting.

9. Click OK to save your settings and exit the printer software.

10. Click Close, OK, or Print to print your backlit display.
(You may need to click a series of these buttons, depending
on your software.)

Printing a Backlit Display on a Macintosh

1. Create the document in your word processor or other
application software.

2. Choose Page Setup from the File menu. You see a dialog
box like the following:

Click to select your Click to select
paper size your paper source
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Choose the Paper Source you're using, either Auto Sheet

Feeder (for the paper tray) or Manual Feed Slot (for the
manual feeder).

Then select the size of your back light film in the Paper
Size option. Click OK.

Choose Print from the File menu or click the print icon in
your application. You see the printing dialog box.

Click for more information
about printer settings
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Click to select your media type

Select Ink Jet Back Light Film as the Media Type setting.
This chooses the best printer driver settings for printing on
back light film and automatically turns on the Flip
Horizontal feature so your image will appear correctly
when viewed from the reverse side.

Check the rest of the printer software settings as described
in Chapters 1 and 2.

If you change any printer settings, make sure that Flip
Horizontal is still selected. Then click Print to print your
backlit display.



Managing
Print Jobs and
Network Printing

Your printer software includes several utilities for managing
print jobs. You can use them to monitor your printer’s status,
set up large jobs to print later, and handle network printing. If
you're using your printer on a network, you need to follow the
special setup procedures in this chapter.

This chapter provides instructions for the following:

Managing print jobs with Windows 95 or 3.1
Managing print jobs with Windows NT
Managing print jobs on a Macintosh
Network printing on a PC

Network printing on a Macintosh

Managing Print Jobs With
Windows 95 or 3.1

Your Windows printer software includes two management
utilities: the Spool Manager and Status Monitor.

The Spool Manager starts automatically when you send a
job to the printer. It allows you to print in the background
while you continue to work on your computer and to hold
jobs to print at a later time. If you’re using your printer on a
network, it also handles multiple print jobs that come in at
the same time.
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Note:
The Status Monitor

doesn’t appear if you're
printing over a network.

In Windows 3.1, you
may not see the Spool
Manager icon if the
Program Manager or
current window is
maximized. Make the
window smaller to see

the Spool Manager icon.

file

& =71 P50
print job

» The Status Monitor, which is available only if you're using
Windows 95, also starts automatically when you send a job
to the printer. It displays on your screen to alert you about
printer, paper, and ink status.

Using the Spool Manager

The Spool Manager works like the Windows Print Manager.
When you send a job to your printer, your printer software
creates a temporary print job file, stores it in the CATEMP or
CAWINDOWS\TEMP folder or directory, and assigns it to a
print queue. The software then sends the file to your printer at
the right time.

» To open the Spool Manager while you're printing, click
the Spool Manager icon that appears on the Taskbar
(Windows 95) or at the bottom of your desktop
(Windows 3.1).

» Toopen itatany time, double-click the Spool Manager4
icon in the EPSON program group or folder.

You see the Spool Manager window:
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The Spool Manager window displays the status of your print
queues and print jobs and lets you control them. Here are some
of the things you can do:

» Hold or release a queue
» Send print jobs to your printer over a network

» Hold, re-queue, or delete a print job
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For information about

any of these procedures,

use the Spool Manager
Help utility.
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» Prevent the Despooler window from appearing on your
screen whenever you print (see page 1-7 for information on
the Despooler window)

» Change your default spool directory

Deleting a Stalled Print Job

If you have trouble printing, it may be because of a stalled print
job. Follow these steps to delete it so you can continue printing:

1. Open the Spool Manager as described on page 4-2.

2. Click on any print jobs marked Held, then open the
Document menu and click Delete.

3. Click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is
very slow, you can try changing your default spool directory.
Follow these steps:

1. Make a directory on your hard disk where you want
Spool Manager to store print job files, for example,
C:\SPLTEMP.

2. Open the Spool Manager as described on page 4-2.
3. Choose Default Spool Directory from the Options menu.

4. In the dialog box, change the spool directory to the one you
created in step 1. Then click OK.

5. Make sure EPSON Stylus COLOR 3000 is selected, and
then choose Setup from the Queue menu. The Queue
Setup dialog box appears.
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6. Make sure the spool directory is the same as in step 1. Also
make sure Use Print Manager for this port is checked. (If
you're using Windows 95 and don’t see the Status Monitor
when you print, leave it unchecked.) Click OK.

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using Windows 95,
displays automatically in the Despooler window when you send
aprint job to the printer. However, you can use it at any time to
see how much ink you have left. Follow these steps:

1. Access the Main printer settings dialog box as described on
page 1-2 (Windows) or page 1-10 (Macintosh).

2. Click the Utility tab. You see the Utility menu:
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Note:

To scroll through the
settings in the Paper
Status box and see the
full names of the listed
options, click in the field
you want to view and use

the arrow keys to view
the option name.
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3. Click the EPSON Status Monitor icon.

You see the Despooler window. If you are using
Windows 95, you also see the Status Monitor (Media
Check, Paper Status, and Ink Status) at the top:

. e ; IETTE AN
Status Monitor o P e

(Windows 95 only) |

Despooler —|

4. Check the amount of ink and paper you have left. For more
information about the Despooler window, see page 1-7.
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Managing Print Jobs With
Windows NT

Windows NT 4.0 servers and workstations include a messenger
service to alert you to printer errors or let you know when a
print job is finished. If you have appropriate network access
privileges or you're controlling printing from the server, you
can also cancel, pause, or restart print jobs and set the sharing,
security, scheduling, and port options. See your Windows NT
documentation for details.

You can check the status of your print job in

Windows NT 3.51 using the Print Manager. Options in the
Print Manager window let you pause, resume, or delete print
jobs and handle the print queues on your system, depending on
your network access privileges. See your Windows NT 3.51
documentation for instructions.

Managing Print Jobs on a
Macintosh

Your Macintosh printer software includes two utilities for
managing your print jobs: EPSON Monitor2 and Status
Monitor.

» If you're using background printing, EPSON Monitor2
starts automatically when you send a job to the printer. It
handles printing while you continue to work on your
Macintosh and lets you track documents that are waiting to
be printed.

» The Status Monitor alerts you to any problems that occur
during printing. You can also use it any time to see how
much ink you have left.
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Background printing is
slower and may also slow
down your system.
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Using EPSON Monitor?2

The EPSON Monitor2 utility lets you continue to work on your
Macintosh while your document is printing. To use this utility,
however, you need to turn on background printing and increase
the memory allocation for EPSON Monitor2.

Follow these steps:

1.

If you didn’t turn on background printing when you
selected your printer, open the Chooser from the Apple
menu. Select the EPSON Stylus(EX) or EPSON
Stylus(AT) icon. Under Background Printing, click On
and close the Chooser.

To increase the memory allocated to Monitor2, select
EPSON Monitor2 in the Extensions folder in your System
folder. Then choose Get Info from the File menu and set
the Memory Requirements to 2000K or 3000K, depending
on your system’s available RAM.

To use Monitor2 while you’re printing, select the EPSON
Monitor2 icon in the Application menu at the right end of
the menu bar. You see a dialog box like the following:
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You can select a job and cancel it or just use this window to
track the print job’s progress.
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Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your
printer and to control the way your software warns you about
printer problems. Follow these steps:

1. Choose Print from the File menu or click the print icon in
your application. You see the printer settings dialog box.

2. Click the Utility button. You see the Utility menu:

For

information
about these —
three utilities,
see Chapter 6
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Click the Status Monitor icon. The software checks the

amount of ink remaining and displays the Status Monitor:
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If you need to install a
network interface board
in your printer, see
Appendix A for
instructions.
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4. If you want to change printer messages and warnings, click
the Configuration button. You see the following dialog

box:
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5. Choose the options you want and click OK.

Network Printing on a PC

You can use your printer on a network under Windows NT,
Windows 95, or another network operating system. First you
need to set up your printer using either the network’s printer
setup functions or your printer software’s built-in network
support.

If you're setting up your printer for Windows NT, see the
instructions below. For other network operating systems, see
your network documentation for instructions or use the printer
software’s network support, as described on page 4-12.
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If you connected the
printer directly to a
Windows NT server or
you’re using a different
network protocol, see
your Windows NT
documentation for
instructions on
configuring your printer
for the network. If you're
using an optional
interface card, also see
the documentation that
came with the card.

Connecting to the Printer on
Windows NT 4.0 Systems

If you installed an optional network interface card in your
printer and installed the printer software as described in the
Quick Setup booklet, follow the steps below to connect the
remote printer to each system on the network using the TCP/IP
(or LPR) protocol.

1. Follow the instructions to configure the interface card in
the manual that came with the card.

2. To connect the printer to a TCP/IP (or LPR) port, open
the Control Panel and select Printers.

3. Right-click the EPSON Stylus COLOR 3000 icon, then
select Properties.

4. Select the Ports tab and click the Add Port button.
5. Select LPR Port in the Port list. Then click New Port.

6. Type the IP address of the card in the first box and type a
short name for the printer in the second box. Then click
OK.

7. Click Close.

8. You see the address and name of the printer in the Port list.
Click OK to exit printer properties.

Now you can print to the remote printer. Repeat these steps for
each system on the network that needs to access the printer.
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If you connected the
printer directly to a
Windows NT server or
you’re using a different
network protocol, see
your Windows NT
documentation for
instructions on
configuring your

printer for the network.
If you’re using an optional
interface card, also see
the documentation that
came with the card.

If you’ve connected

the printer to a server,

be sure to install the
Windows NT 3.51 drivers
on all workstations that
will share the printer over
the network.
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Connecting to the Printer on
Windows NT 3.51 Systems

If you installed an optional network interface card in your
printer and installed the printer software as described in the
Quick Setup booklet, follow the steps below to connect the
remote printer to each system on the network using the TCP/IP
(or LPR) protocol.

1. Follow the instructions to install the LPR software and
configure the interface card in the manual that came with
the card.

2. To configure the printer for TCP/IP (or LPR) printing,
double-click the Print Manager icon in the Main program
group.

3. Select the EPSON Stylus COLOR 3000 window.
4. Choose Properties in the Printer menu.
5. Select Other in the Print to list.

6. Select LPR Port in the Available Print Monitors list and
click OK.

7. Type the IP address of the card in the first box and type a
short name for the printer in the second box. Then click
OK.

8. Click OK again, then exit Print Manager.

Now you can print to the remote printer. Repeat these steps for
each system on the network that needs to access the printer.
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Using the Printer Software’s Built-in
Network Support

To use your printer software’s built-in network support, you
first need to install the printer software on all the network
computers that will use the printer. See the Quick Setup booklet
for instructions. Once the printer software is installed, you can
set up Spool Manager to send print job files from each
computer to a shared directory on the computer connected to
the printer.

Follow the steps in the next sections to set up a print job
directory on the system connected to the printer (the host
system) and each remote system (client) on the network. For
Windows 95, you also need to specify the port and network
path to the printer, as described on page 4-13.

Setting Up the Host System

Follow these steps to set up the computer connected to the
printer:

1. Create an icon for the EPSON Spool Manager
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder
or directory).

2. Place this icon in the Startup folder.

3. Double-click the EPSON Spool Manager icon to open the
Spool Manager window.

4. Double-click the queue you want to use for network
printing. The Queue Setup dialog box appears.

5. Click the Remote Despool tab and then click the
Printing from remote queues option.
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6. Click the Browse button and select the remote server
directory that will receive print job files.

7. Click OK and minimize the Spool Manager window.

Setting Up Remote Systems

Follow these steps to set up the client computers on the
network:

1. Open the Spool Manager window as described on page 4-2.

2. In the Spool Manager window, double-click the queue you
want to use for network printing. The Queue Setup dialog
box appears.

3. Click the Spool to remote printer button.

4. Click the Browse button and select the directory you're
using for print job files on the host system.

5. Click OK and minimize the Spool Manager window.

Setting Up Your Network Path in Windows 95

If you want to use your printer on a network running
Windows 95, you need to set up the port and network path on
the computer connected to the printer. Follow these steps:

1. Double-click My Computer.

2. Double-click the Printers folder.
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If you want to print from
DOS applications as well
as from Windows
applications, click the
Capture Printer Port
button instead of the
Add Port button. In the
Device box, select the
printer port your printer
is connected to, then
specify the network path
to the printer. Make sure
Reconnect at logon is
selected, then click OK.

3. Right-click the EPSON Stylus COLOR 3000 icon and
choose Properties.

4. Click the Details tab. The following dialog box appears:

5. Click the Add Port button, then specify the network path
to the printer and click OK.

6. Open the Spool Manager window as described on page 4-2.

7. In the Spool Manager window, double-click your printer’s
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is
checked. Then click OK.
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Network Printing on a Macintosh

If you want to use your printer on an AppleTalk® network, you
need to install an optional interface board: either the

Local Talk® board or the Ethernet™ board. See Appendix A for
more information about optional interfaces.

Then you can use the EPSON Namer utility and set up your
printer in the Chooser. The EPSON Namer was installed on
your hard drive along with the other printer software.

Assigning a Name to the Printer

Follow these steps to use the EPSON Namer utility:

1.

2.

Double-click the EPSON Namer icon on your hard drive.

Click the EPSON Stylus(AT) icon in the Device Types
window.

Select the AppleTalk zone where your printer is located.

Under New Name, type a name from your printer to
distinguish it from other printers on the network.

Click Rename and then click Done.
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Setting Up the Printer for AppleTalk

Make sure your printer is turned on and then follow these steps
to set up your printer on an AppleTalk network:

1. Open the Chooser from the Apple menu. You see a dialog
box like the following:
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2. Click the EPSON Stylus(AT) icon.

3. Select the AppleTalk zone you want to use. A list of all
printers connected to the selected zone appears on the right.

4. Click the name you assigned to your EPSON Stylus COLOR
3000 in step 4 of the previous section. You see a prompt
asking you to confirm your choice.

5. Click OK.

If your printer name doesn’t appear, make sure the printer
is turned on and correctly connected, then click RETRY.

6. To ensure compatibility, leave Background Printing
turned off.

7. Close the Chooser.
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Note: j

If you are using

AutoCAD 386 release 10
or higher, you need to use
the Autodesk Device
Interface (ADI) plotter
driver. See the README
file on the driver diskette
for more information.

5 Using Your
@ Printer with
DOS

If you print with DOS application programs, you can use your
printer with them by following the instructions in this chapter.
It covers these operations:

»  Selecting printer software for DOS
»  Changing printer settings with default-setting mode

»  Performing printer maintenance procedures, such as
aligning the print heads

»  Selecting character tables

»  Using printer commands

Selecting Printer Software for DOS

You select software (a printer driver) for your printer in each
DOS program you use. Most DOS programs include drivers for
EPSON ESC/P 2™ printers. You need to select the correct
printer driver to take advantage of your printer’s advanced
built-in scalable fonts and graphics handling.

Most DOS programs require you to select from a list of
available printer drivers. If EPSON Stylus COLOR 3000 is not
included in the list, you can contact your software manufacturer
to obtain an updated driver.

If an updated driver is not available, pick the first printer
available in the lists on the next page.
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N\
all

Note:

The drivers for the printers
listed do not provide all
EPSON Stylus COLOR
3000 features, such as
1440-dpi printing, 720-dpi
printing, and MicroWeave.

When printing black and color, select:

EPSON Stylus 1500

EPSON Stylus COLOR 1520
EPSON Stylus Pro

EPSON Stylus Pro XL
EPSON Stylus COLOR 500
EPSON Stylus COLOR 1
LQ-2550

LQ-1060

When printing black only, select:

LQ-870
LQ-1170
LQ-570+
LQ-1070+
SQ-870
SQ-1070
LQ-850
LQ-500

Once you've selected a printer driver for each DOS program
you use, you can begin printing. Be sure to check the paper
source and other printer driver settings before printing.

If you want to adjust any of the printer’s internal settings, you
can use default-setting mode as described in the next section.

To perform routine printer maintenance procedures, see
page 5-7 for instructions.
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Note: j

The printer’s control panel
buttons perform different
functions while the printer
is in default-setting mode.
Be sure to carefully follow
the instructions your
printer prints and don’t
try to perform standard
control panel functions
until you’ve exited
default-setting mode.
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Changing Printer Settings With
Default-Setting Mode

Your printer includes internal default settings that are active
whenever you turn on the printer. These settings control
functions such as the print direction and paper loading
positions.

Because they are preset to the most likely settings you’ll want to
use, you probably won't need to change them. However, you
may want to change settings such as these for special projects:

» Turn on auto tear-off mode when you print on continuous
paper or roll paper (but not when printing continuous label

paper)
» Turn on banner mode when you print on roll paper

»  Select a slashed zero (@) instead of a regular zero (0) when
you print documents where the zero can easily be confused
with a capital “O”

You can check or change the default settings using the printer’s
control panel. Follow the steps in the next section.

Entering Default-Setting Mode

To enter default-setting mode and print an instruction sheet in
one of six languages, follow these steps:

1. Load four or more sheets of paper at least 8.3 inches
(210 mm) wide into the paper tray. See page 3-7 for
loading instructions.

2. Turn off the printer.
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3. While holding down the Media Type button, press the

Operate button to turn on the printer to enter
default-setting mode. Hold down both buttons for three
seconds, then release them.

The printer loads a sheet of paper and prints an instruction
sheet telling you how to select a language (the default
setting is English).

If you want to print the default-setting instructions in

another language, press the Micro Adjust # button until
the Ink Out & Yellow and Ink Out & Magenta lights on
your control panel indicate the language you want to use.

Language Lights
English Both lights off
French Ink Out & Yellow on and Ink Out & Magenta off
German Ink Out & Yellow flashing and
Ink Out & Magenta off
Italian Ink Out & Yellow off and Ink Out & Magenta on
Spanish Both lights on
Portuguese | Ink Out & Yellow flashing and
Ink Out & Magenta on

5. Press the Pause button. The printer prints instructions on
changing the default settings.

6. Follow the instructions on the sheet to change the necessary
settings, as listed in the next section. Your changes remain
in effect until you change them again. (To exit without
changing any settings, press the Pause button.)

7. When you're finished changing settings, press Load/Eject
if you need to eject any loaded paper. Then turn off the
printer to exit default-setting mode.

8. Wait five seconds, then turn on your printer to resume

printing.
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List of Default-Setting Options

The table below lists all the options available for each default
setting. The factory defaults are listed in bold type in the table
below. The printer’s current settings are marked with a 0 on
your printed instruction sheet.

Setting

Options

Description

Print direction

Auto, Bi-D, Uni-D

Auto switches between bidirectional printing for
text data (the print head prints in both directions)
and unidirectional printing for graphics data. For
the fastest printing of text only, select Bi-D; but if
vertical lines become misaligned, you’ll need to
turn it off or align the print heads (see page 5-7 for
instructions). For the most accurate alignment
when printing graphics, select Uni-D.

Font Courier, Roman, If your software doesn’t let you select fonts, you
Sans Serif, can select one of these bitmap or scalable fonts.
Prestige, Script, See Appendix C for a list of the point size and
Roman T, Sans characters per inch available with each font.
Serif H, Draft

Pitch 10, 12, 15, 17.1, or | If your software doesn’t let you select point size or

20 cpi, or
Proportional

characters per inch for your fonts, you can select
one of these. See Appendix C for a list of the point
size and characters per inch available with each
font.

I/F (interface) mode

Auto, Parallel,
Serial, Option

When your printer is connected to multiple
interfaces, Auto sets the printer to receive data
from any interface sending a print job. Select
Parallel, Serial, or Option only if you want your
printer to ignore print jobs sent from other
interface types.

Auto I/F (interface) wait

time

10 or 30 seconds

If you choose Auto for the I/F mode setting,
selects the time the printer waits for a print job
from one interface before accepting a print job
from another interface.

Software (emulation
mode)

ESC/P 2, IBM
XL24E

Specifies the control mode you want the printer to
use. For the best font and graphics control, always
use ESC/P 2 mode. If you need to emulate an
IBM® Proprinter," select IBM XL24E mode. For a
list of the commands for these modes, see

page 5-17.
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Setting Options Description

Auto CR (IBM XL24E Off, On In IBM XL24E mode, lets you select whether the

mode only) printer performs a carriage-return line-feed
operation when it reaches the right margin (On) or
only when it receives a carriage-return code in the
print job (Off).

AGM (IBM XL24E Off, On In IBM XL24E mode, turns high resolution, 24-pin

mode only) graphics command mode on or off.

Character table — See the samples beginning on page 5-8. The
default character table is PC437.

International character | — See the samples beginning on page 5-8. The

set for Italic table default character set is Italic U.S.A.

Auto line feed Off, On Sets the printer to either perform a line-feed
operation every time it receives a carriage-return
command (On) or not to perform one (Off).

Network I/F (interface) | Off, On Sets whether the printer is (On) or is not (Off)

mode shared by more than one computer.

0 slash 0,0 Selects either a slashed zero (@) or a regular

zero (0) to be printed when a zero command is
received.

Page length for
continuous paper

11, 12, 8.5, or 70/6
inches or Other

When printing on continuous paper, select the
length of the individual sheets. 70/6 is the length
of A4-size paper.

Skip over perforation Off, On If your software doesn’t let you set top and
bottom margins, turn this setting On to add a
one-inch margin over the perforation to separate
text on continuous pages.

Auto tear off Off, On When printing on continuous paper or banner

paper, turn this setting On to advance the
perforation or end of the sheet to the printer’s
tear-off edge. It also backs the paper up to the
top-of-form position when it receives the next
print job. Turn this setting Off when printing on
continuous labels so they don’t tear off inside the
printer.
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Setting

Options Description

Banner mode

Off, On When you turn this mode On, banner paper is
treated as continuous paper, even with the
paper-release lever in the single sheet position.
This prevents the printer from advancing too much
of the banner paper forward when you press the
LF/FF button.

Parallel I/F (interface)
transfer rate

Fast, Normal Sets the transfer rate for printing across the
parallel port. Always select Fast unless you
receive transfer rate errors.

Ly

If vertical lines are
misaligned, first make
sure you did not set the
Print direction setting to
Bi-D (bidirectional) in
default-setting mode.
This may be causing
the problem instead of
misaligned print heads.
See page 5-3 for
instructions on checking
your default settings.

Maintaining the Printer

When you’re printing from DOS applications, you can perform
most printer maintenance operations as they’re described in
Chapter 6, such as replacing the ink cartridges and cleaning the
print heads from the control panel.

However, you'll need to follow the steps in this section if you
need to align the print heads to correct misaligned vertical lines.
You can align them with a DOS utility or by using control
panel commands.

Aligning the Print Heads With a DOS
Utility

Before you can align the print heads, you need to install the
DOS alignment utility. Follow these steps:

1. Make sure your computer and printer are turned on.

2. Load several sheets of paper at least 8.3 inches (210 mm)
wide in the paper tray. Make sure the edge guides are
positioned correctly for your paper size and the
paper-release lever is set to the single sheet position. (See
page 3-7 for instructions.)
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3. Insert the EPSON printer software CD-ROM or diskette
into a drive.

4. At the DOS prompt, type D:\SETUP (where D is the drive
letter of your drive) and press Enter.

\ 5. You see an installation instruction screen. Follow the
instructions on the screen to install the utility on your
computer’s hard disk drive.
A 6. Once the utility is installed, log onto the directory you
Note: specified for the utility. Then type EPCALIB and press

You can use a mouse
with the utility if you have

a DOS mouse driver . . - .
installed. 7. You see the EPSON Print Head Alignment Utility main

screen. Make sure your printer is listed on the screen and
select Next.

Enter to start the program.

8. Follow the instructions on the utility screens to align your
print heads.

\ Selecting Character Tables

application software. If you can’t select them with your
software, follow the instructions here to select one of the
printer’s internal character tables.

! Most of the time you can select character tables using your

Note:
Some tables contain the
same characters for hex

codes 00 to 7E as the You can select a character table using default-setting mode (as

PC437 table, so these described on page 5-3) or printer software commands (as
samples list only described on page 5-17). Each character table is identified by
characters for codes the code shown beneath the sample, beginning on the next
80 to FF. page.
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International Character Sets

You can select one of these international character sets using

default-setting mode (as described on page 5-3) or the ESC R
command (as described on page 5-17). When you select a
character set, such as Italic France, the characters in the France

row on the table below are used in the italic character table.

You can select one of these eight international character sets

using default-setting mode or ESC R.

Courntry

ASCI code e
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You can select one of these seven sets using ESC R only.
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Characters Available With the ESC (»
Command

To print with the characters listed below, use the ESC (
command as described in the next section.

ODE |4 1 7
a "
1 | = 4=
2 |@® 1
a |wv 1
4 | & 1
5 | &

a | & _
T |~
a (B
2 | e |
& |@ -
a8 | & =
C |® =
o> | & =
E |®” &
F la v n

Using Printer Commands

You can operate your printer by using commands in one of two
control code modes. For the best font and graphics control,
always use EPSON ESC/P 2 mode. (For details on using
ESC/P 2, see the ESC/P Reference Manual available from
EPSON.)

If you need to emulate an IBM Proprinter, select IBM XL24E
mode. (See IBM’s X24/X24E reference manual.)



Using Your Printer with DOS

ESC/P 2 Control Codes

General operation:
ESC@, ESC U, ESC EM

Paper feeding:
CR, FF, LF, ESC 0, ESC 2, ESC 3, ESC +

Page format:
ESC (C,ESCC,ESC CO0,ESC Q, ESC I, ESC ( c,
ESC N,ESC O

Print position motion:
ESC $,ESC\, ESC (V, ESC (v, ESC D, HT, ESC B,
ESCJ, VT

Font selection:
ESC k, ESC x, ESC X, ESC P, ESC M, ESC g, ESC p,
ESC 4, ESC 5, ESC E, ESC F, ESC !

Font enhancement:
ESC W, DC 4, SO, DC2, SI, ESC w, ESC G, ESC H,
ESCT,ESCS,ESC -, ESC (-, ESCq

Spacing:
ESC space, ESC ¢, ESC (U

Character handling:
ESCt, ESC (t, ESC R, ESC %, ESC &, ESC :, ESC 6,
ESC 7,ESC (~

Bit image:
ESC *

Graphics:
ESC (G, ESC ., ESC (e, ESC (i, ESC (\,ESC (s

Color:
ESCr, ESC (r

Printing mode:
ESC (K



Using Your Printer with DOS

IBM XL24E Emulation Control Codes

General operation:
NUL, DC3, ESC j, BEL, CAN, DC1, ESC Q, ESC [ K,
ESCU

Paper feeding:
FF, LF, ESC 5, ESC A, ESC AL, ESC 0, ESC 1,
ESC 2, ESC 3, ESC 3%, CR

Page format:
ESC C,ESC X, ESC N, ESC O, ESC 4

Print position motion:
ESC d, ESC R, ESC D, HT, ESC B, VT, ESC J, ESC J!

Font selection:
DC2,ESC P, ESC:, ESCE, ESCF, ESC |

Font enhancement;
DC4, SO, ESC SO, ESC W, ESC[ @, SI, ESC SI, ESC G,
ESC H,ESC T,ESC S, ESC -, ESC _

Spacing:
BS, SP, ESC [\

Character handling:
ESC 6,ESC7,ESC[ T, ESC " ESC\

Bit image:
ESC K, ESC L, ESC Y, ESC Z, ESC [ g, ESC **

1 Alternate Graphics Mode
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Note:

You must print a few lines
(for example, a nozzle
check) after each print
head cleaning in order to
reset the cleaning cycle.

Maintenance a_nd
T ransportation

It’s easy to keep your EPSON Stylus COLOR 3000 printer
working at its best. All you have to do is follow the simple
instructions in this chapter for replacing ink cartridges,

performing routine maintenance, and moving the printer.

This chapter covers the following procedures:
»  Cleaning the print heads

» Replacing an ink cartridge

»  Aligning the print heads

»  Cleaning the printer

» Transporting the printer

Cleaning the Print Heads

If your printed image is unexpectedly light or faint, or dots are
missing from the image, you may need to clean the print heads.
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print
quality declines. There are two ways to clean the print heads:

» The Head Cleaning utility in your printer software

» The printer’s control panel buttons.

Use either method if your printer is connected directly to the
computer. Use the control panel if your printer is connected via
an optional network interface card.
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If any Ink Out lights

are flashing or on, you
need to replace the ink
cartridge instead. See
page 6-4 for instructions.

If you were printing when
you started cleaning the
print heads, the Pause
light may still be on. Press
the Pause button to turn
off the light and resume
printing.
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Caution:

Never turn off the printer
while the Pause light is
flashing.

If, however, the Pause
light is still flashing after
10 minutes and the
printer is not moving or
making any noise, you
may turn off the printer.

Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows computer
or a Macintosh:

1.

2.

Make sure the printer is turned on but not printing.
Make sure all the Ink Out # lights are off.

Access the Main printer settings dialog box as described in
Chapter 1.

Click the Utility tab (Windows) or the Utility button
(Macintosh). You see the Utility menu.

Click the Head Cleaning icon.

Follow the instructions on the screen to clean the print
heads. You can clean the black or color print head
separately, or you can clean both. Cleaning each head takes
up to three minutes, during which the printer makes some
noise and the Operate and Pause lights flash.

When the lights stops flashing, you need to run a nozzle
check to test the print quality and reset the cleaning cycle.

Make sure paper is loaded in the printer and click Print
nozzle check pattern (Windows) or Confirmation
(Macintosh), and then click Next. See page 6-4 for
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If
you don’t notice any improvement after doing this four or five
times, check the print quality solutions in Chapter 7.
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If any Ink Out lights

are flashing or on, you
need to replace the ink
cartridge instead. See
page 6-4 for instructions.

If you were printing when
you started cleaning the
print heads, the Pause
light may still be on. Press
the Pause button to turn
off the light and resume
printing.
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Caution:

Never turn off the printer
while the Pause light is
flashing.

If, however, the Pause
light is still flashing after
10 minutes and the
printer is not moving or
making any noise, you
may turn off the printer.

Maintenance and Transportation

Using the Control Panel

1.

2.

Make sure the printer is turned on and not printing.
Make sure all the Ink Out & lights are off.

To clean the black print head, press the & Cleaning button
for three seconds.

To clean the color print head, press the & Cleaning
button for three seconds.

Cleaning each head takes up to three minutes, during
which the printer makes some noise and the Operate and
Pause lights flash.

After the cleaning cycle is complete and the Pause light
stays on without flashing, you can repeat step 3 to clean the
other print head, if you wish. Then you need to run a
nozzle check to test the print quality and reset the cleaning
cycle.

Access the Main printer settings dialog box as described in
Chapter 1.

Click the Utility tab (Windows) or the Utility button
(Macintosh). You see the Utility menu.

Click the Nozzle Check icon, then click Next. See the next
section for instructions on examining the nozzle check
pattern.

If your print quality has not improved, repeat the steps above. If
you don’t notice any improvement after doing this four or five
times, check the print quality solutions in Chapter 7.
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Caution:

For best results, don’t
replace an ink cartridge
unless its Ink Out light is
flashing or on.

If you remove an ink
cartridge and reinstall
it, the printer cannot
correctly determine the
level of ink and the Ink
Out light may not come
on when the cartridge
runs out of ink.

To ensure good results,
use genuine EPSON
cartridges and do not refill
them. Other products may
cause damage to your
printer not covered by
EPSON’s warranty.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. 1t should look
something like this, with the lower pattern colored cyan,
magenta, and yellow:

W01372 C01267

Each staggered horizontal and straight vertical line should be
complete, with no gaps in the dot pattern. If your printout
looks okay, you're done. If any dots are missing, clean the print
heads again, as explained in the previous sections.

Replacing an Ink Cartridge

When an Ink Out & light flashes, the indicated cartridge is low
on ink. This is a good time to make sure you have a new
cartridge. When the light stays on, the cartridge is empty and
you need to replace it.

Use EPSON ink cartridges within six months of installing them
and before the expiration date on the package:

Black ink cartridge S020118
Cyan ink cartridge 5020130
Magenta ink cartridge  S020126
Yellow ink cartridge 5020122

When you need new ink cartridges, contact your dealer or call
EPSON Accessories at (800) 873-7766 (U.S. only). In Canada,
please call (800) 873-7766 for dealer referral.
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Caution:

Leave the empty cartridge
installed in the printer until
you are ready to replace it.

Once you remove an ink
cartridge, it becomes
unusable and cannot be
reinstalled.

X

Warning:

If ink gets on your hands,
wash them thoroughly with
soap and water. If ink gets
into your eyes, flush them
immediately with water.

Maintenance and Transportation

Removing and Installing an Ink Cartridge

You should replace an ink cartridge only when its Ink Out
light is flashing or on.

1.

2.

Make sure the printer is turned on and not printing.

Open the ink cartridge compartment by pushing the top of
the ink compartment door. You see four slots for the ink
cartridges.

Carefully pull the used ink cartridge straight out of the
printer.

Make sure the replacement ink cartridge is the correct
color; then remove it from its packaging.

Insert the ink cartridge into the slot with the foil plug end
first and the arrow pointing toward the printer. Push the
cartridge all the way into its slot until it meets resistance.

The Ink Out light turns off. If it remains on, pull the ink
cartridge partly out of its slot and reinsert it.

Close the ink compartment door.
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Caution:

If you’re printing on
continuous label paper,
don’t press Load/Eject;
this feeds the paper
backward and may cause
labels to tear off inside
the printer. Follow the
steps on page 3-19
instead.

Printing in Black Ink With an Empty Color
Cartridge

If a color ink cartridge runs out of ink and its Ink Out & light
comes on, you can still continue printing with black ink. (If the
black ink cartridge runs out of ink, you cannot continue
printing.) However, you will need to resend any print job you
were printing when the color ink ran out. Follow these steps:

1. Turn off the printer.

2. Wiait about five seconds and then turn the printer back on
again. Don’t remove the empty color ink cartridge.

3. If there is paper in the paper path, press the Load/Eject
button to eject it or to advance continuous paper to the
tear-off edge. Tear off any continuous sheets and press
Load/Eject again to park the continuous paper out of the
path.

4. Access the printer software in your application as described
in Chapter 1. Change the Ink setting for your document to
Black and change any other settings as necessary. Then
print the document.

To switch back to color printing, follow the steps beginning on
page 6-5 to replace the color ink cartridge. Then turn the
printer off and on again to reset color printing mode. Before
you print, be sure to set the Ink setting to Color in your printer
software as described in Chapters 1 and 2.
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Caution:

Load paper that’s at least
8.3 inches (210 mm) wide
so ink doesn’t spray onto
the platen.

Maintenance and Transportation

Aligning the Print Heads

If your printouts contain misaligned vertical lines, you may
need to align the print heads. There are several ways to do this:

» If you're using Windows or a Macintosh, you can use the
print head alignment utility in your printer software, as
described below.

» You can also use the control panel to align the print heads.

» Ifyou're printing from DOS, see page 5-7 for instructions
on using the DOS print head alignment utility.

Use one of the utilities if your printer is connected directly to
the computer. Use the control panel if your printer is connected
via an optional network interface card.

Using the Print Head Alignment Utility

1. Make sure the printer is turned on and paper is loaded in
the paper tray (see page 3-7 for instructions).

2. Access the Main printer settings dialog box as described in
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print an alignment
test page and select the correct alignment.
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Using the Control Panel

1. Load several sheets of paper at least 8.3 inches (210 mm)
wide in the paper tray.

2. Move the paper-release lever backward to the single sheet
position.

/

_—

3. Turn off your printer.

4. Hold down the Pause button and turn on the printer to
turn on print head alignment mode. Be sure to hold down
both buttons for three seconds before releasing them.

The printer loads a sheet of paper and prints an instruction
sheet telling you how to select a language (the default
setting is English). The printer can then print instructions
on aligning the print heads in the language you choose.

5. Press the Micro Adjust # button until the Ink Out
Yellow and Ink Out & Magenta lights on your control
panel indicate the language you want to use.

Language Lights

English Both lights off
French Ink Out & Yellow on and Ink Out & Magenta off
German Ink Out & Yellow flashing and

Ink Out & Magenta off
Italian Ink Out & Yellow off and Ink Out & Magenta on
Spanish Both lights on

Portuguese Ink Out & Yellow flashing and
Ink Out & Magenta on
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Caution:

Don’t touch the gears
inside the printer.

Never use alcohol or
thinner for cleaning; they
can damage the printer
components and case.

Don’t use a hard or
abrasive brush.

Don’t get water on the
printer components.

Don’t spray lubricants or
oils inside the printer.

Maintenance and Transportation

Press the Pause button. The printer prints instructions on
aligning the print heads using the control panel.

Follow the instructions on the sheet. When the print heads
are aligned, turn off the printer to exit print head alignment
mode.

After five seconds, turn on the printer to resume printing.

Cleaning the Printer

To keep your printer working at its best, you should clean it
several times a year, following these steps:

1.

Turn off the printer, unplug the power cord, and
disconnect the printer cable.

Remove the paper from all the paper feeders.

Clean the exterior of the printer with a soft, damp cloth.
Keep the printer cover closed so water doesn’t get inside.

Clean ink out of the printer’s interior with a soft, damp
cloth.

Transporting the Printer

If you want to ship your printer, you need to prepare it for
transportation and repack it in the original box. Follow these

steps:

1. Turn on the printer.

2. Remove all four of the ink cartridges and store them in
separate plastic bags.

3. Close the ink compartment door.
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Caution:

If you don’t follow the
procedures in this
section, ink will leak

when you transport the
printer.

However, if you are
moving your printer a
short distance, for
example, from one table
to another, you don’t
need to remove the ink
cartridges. Be sure to
keep the printer level
when you move it.

4. Turn off the printer and make sure the print heads are in
the home (far right) position. If they are not, turn the
printer back on, wait until they stop moving and are in the
home position, then turn off the printer.

5. Wait until the printer stops making noise and any lights
stop flashing, then unplug the power cord from the
electrical outlet and disconnect the interface cable from the
printer.

6. Remove the paper from all the feeders.
7. Remove the edge guides and banner paper cover.
8. Remove the paper tray and paper tray cover.

9. Repack the printer and attachments in the original box
using the protective materials that came with it. See the
Notice Sheet that was packed with the printer.

Be sure to keep the printer level in an upright position as you
transport it.

If you reinstall the cartridges that were removed in step 2, the
ink sensor will not correctly indicate the amount of ink in the
cartridges. You may run out of ink before the Ink Out lights
flash or come on. If you want the ink sensor to work properly,
you need to install new ink cartridges. See page 6-4 for
instructions.

If you notice a decline in print quality after transporting the
printer, clean the print heads; if output is misaligned, align the
print heads. See the instructions earlier in this chapter.
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T roubleshooting

As you use your printer, you may occasionally experience a
paper jam or other problem. The first thing you should do is
diagnose the problem following the guidelines in this chapter.
Then try the most likely solutions until the problem is fixed.

This chapter tells you everything you need to know about the
following:

Diagnosing problems

Improving print quality

Solving printing problems

Fixing paper jams and other paper problems

Solving miscellaneous printout problems

Diagnosing Problems

Your printer includes a number of ways to help you diagnose
problems:

To identify the most common problems, check the lights
on the printer’s control panel. See page 1-14 for
instructions.

You can also use the Status Monitor utility to identify
common problems. For instructions, see page 4-4
(Windows 95) or page 4-8 (Macintosh).

To determine whether the problem is caused by the printer
itself, run a printer self test. See the next section for
instructions.
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Caution:

Use paper that’s at least
8.3 inches (210 mm)
wide. Otherwise the print
head will spray ink directly
onto the platen.

If you're experienced with reading hexadecimal code, you
can print a hex dump to identify possible communication
problems. See page 7-3 for instructions.

For the latest information, check the EPSON Stylus
COLOR 3000 Help program and the ReadMe file in the
EPSON program group or folder.

If none of the suggested solutions in this chapter solve your
problem, contact EPSON as described under “Where to Get
Help” in the Introduction.

Running a Self Test

You can run a printer self test to determine whether the
problem lies with the printer itself or some other source.

If the test results are satisfactory, the problem lies in your
computer or its printer port, the interface cable, or your
software settings.

If the test pages don’t print correctly, you may have a
problem with your printer. See the suggestions in this
chapter for possible solutions.

Follow these steps to test the printer:

1. Load several sheets of paper in the paper tray.

2. Turn off the printer.

3. Hold down the LF/FF button and press the & Operate

button to turn on the printer. Then release both buttons.
This prints the test pages at 360 dpi. (If the test pages don’t
print, turn off the printer. Repeat the button sequence, but
hold down both buttons for several seconds before releasing
them.)
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Caution:

Never turn off the printer
while it is printing. To
end the test, always
press the Pause button,
eject any loaded paper,
then turn off the printer.
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Caution:

Use paper that’s at least
8.3 inches (210 mm)
wide. Otherwise the print
head will spray ink directly
onto the platen.

Troubleshooting

The first page prints on the first and last lines to measure
the page length. The next page contains a nozzle check
pattern and multicolored character samples.

To print test pages at 180 dpi, hold down the Load/Eject
button while turning on the printer instead of LF/FF. The
180-dpi self test prints in black.

After the second page prints, press the Pause button to
stop printing.

If the printer loaded any additional paper, press Load/Eject
to eject it. Then turn off the printer to end the test.

Printing a Hex Dump

If you're experienced reading hexadecimal code, you can print a
hex dump to pinpoint communication problems between your
computer and printer. Then you can interpret the code yourself
or report the results to a support technician.

1.

2.

w

Load several sheets of paper in the paper tray.
Turn off the printer.

Hold down the LF/FF and Load/Eject buttons and press
the O Operate button to turn on the printer. Then release
all the buttons.

Open an application and send a print job. The printer
prints the data in hexadecimal code.

When printing is finished, turn off the printer to exit
hexadecimal mode.
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Improving Print Quality
You can often improve print quality by doing the following:

» Clean the print heads (see Chapter 6 for instructions).

» Use higher quality paper appropriate for your print job (see
Chapter 3 for a list of EPSON papers).

» Match the Media Type setting in the printer software to
the type of media you loaded in the printer (see Chapter 3
for details).

»  Make sure the thickness lever is set to the correct position
for your media (see Chapter 3 for details).

»  Turn off High Speed mode in the printer software (see
Chapter 2 for details).

»  Make sure you're not using an Economy option in the
printer software (see Chapter 2 for details).

» Replace the ink cartridges. (Check the status of the
Ink Out & lights first. See Chapter 6 for instructions.)

Here are some detailed solutions to specific print quality
problems.

Printed image has horizontal banding.

Possible cause

Solution

The Media Type setting
doesn’t match the loaded
paper.

Make sure the Media Type setting matches the loaded paper or
other media. Then the printer software can automatically select
other settings for the best quality. See Chapters 1 through 3.

The printable side of the
paper is loaded upside
down.

Remove the paper and reload it correctly for the media and feeder
you’re using. See Chapter 3 for instructions.

The print head nozzles are
clogged.

Clean the print heads. See Chapter 6 for instructions.

The ink cartridges are low
on ink.

Check the Ink Out # lights to see which cartridge you need to
replace. See Chapter 6.

The MicroWeave option is
not set.

Turn on MicroWeave in the printer software. See Chapter 2 for
more information.
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Vertical lines are misaligned or vertical banding appears.

Possible cause

Solution

The print head nozzles are
clogged.

Clean the print heads. See Chapter 6 for instructions.

High Speed mode or Bi-D
mode are turned on.

If vertical lines are misaligned, turn off High Speed mode in the
printer software (see Chapter 2 for information). If you’re printing
with DOS, turn off Bi-D printing using default-setting mode (see
Chapter 5 for instructions.)

The print heads are
misaligned.

Run the Print Head Alignment utility. See Chapter 6 for Windows
or Macintosh instructions; see Chapter 5 for DOS instructions.

The printed image has incorrect or missing colors.

Possible cause

Solution

The Ink option is set to
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting
doesn’t match the loaded
paper.

Make sure the Media Type setting matches the paper or media
you’re using. Then the printer software can automatically select
other settings for the best quality. See Chapters 1 through 3.

The printable side of the
paper is loaded upside
down.

Remove the paper and reload it correctly for the media and feeder
you’re using. See Chapter 3 for instructions.

The Halftoning and Color
Adjustment Mode
options are set incorrectly
for your document type.

Use the correct settings for the project you are printing, following
the instructions in Chapter 2.

The print head nozzles are
clogged.

Clean the print heads. See Chapter 6 for instructions.

The ICM (Windows 95) or
ColorSync (Macintosh)
settings are incorrect for
your document.

Use the Automatic mode setting or choose a different project
type setting. See Chapter 2 for more information.

The ink cartridges are low
on ink or empty.

Check the Ink Out & lights to see which cartridge you may need to
replace. See Chapter 6 for instructions.

The colors displayed on
your monitor don’t match
the printed colors.

Because your monitor and printer use different technologies to
represent colors, your printed colors cannot exactly match those
on your monitor screen. Use the ICM (Windows 95) or ColorSync
(Macintosh) settings. See Chapter 2 for more information.

The color settings in your
application software need
adjustment.

You may be able to adjust various color settings in your application
software. See your software documentation for more information.
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The printed image is faint or has gaps.

Possible cause

Solution

The print head nozzles are
clogged.

Clean the print heads. See Chapter 6 for instructions.

The Media Type setting
doesn’t match the loaded

paper.

Make sure the Media Type setting matches the loaded paper or
other media. Then the printer software can automatically select
other settings for the best quality. See Chapters 1 through 3.

The loaded paper is upside
down, damaged, old, or
dirty.

Remove the paper and reload a new stack with the printable side
facing correctly. See Chapter 3 for instructions.

The ink cartridges are low
on ink.

Check the Ink Out & lights to see which cartridge you may need to
replace. See Chapter 6 for instructions.

An ink cartridge is out of
ink.

If you replaced an ink cartridge before it’s ink out light came on, the
ink sensor was incorrectly reset. Replace the empty ink cartridge
with a new ink cartridge. See Chapter 6 for instructions. This
resets the ink sensor.

You’re on a network and
the Network I/F setting is
turned off.

Try turning on the Network I/F setting using default-setting mode
to see if this solves the problem. See Chapter 5 for instructions.

You’re using Economy
mode.

Turn off Economy mode. Economy mode is for printing drafts only.

The printed image is blurry or smeared.

Possible cause

Solution

The printer’s thickness
lever is in the 0 position.

Set the thickness lever to the + position and try printing again. See
Chapter 3 for instructions.

The paper is damp or the
printable side is upside
down.

Remove the paper and reload a new stack with the printable side
facing correctly. See Chapter 3 for instructions.

You loaded special media
without a support sheet.

Follow the special media loading instructions in Chapter 3 and on
the paper packaging for media that require support sheets. Also try
loading your media one sheet at a time.

You tried to print on
cardboard or other
non-recommended media.

Make sure your paper or media meets the specifications listed in
Appendix C. If your printouts are still blurry after you change paper,
clean the print heads as described in Chapter 6.

The Media Type setting
does not match the loaded

paper.

Make sure the Media Type setting matches the media you loaded.
Then the printer software can automatically select other settings
for the best quality. See Chapters 1 through 3 for information.
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Possible cause

Solution

The sheets entering the
output tray are smearing
the ink on ejected pages.

Remove each sheet from the output tray as soon as it is printed to
prevent smearing, especially if you use transparencies.

Ink has leaked inside the
printer.

Clean carefully inside the printer to remove spilled ink. See
Chapter 6 for instructions.

A color ink cartridge is
empty and you’ve
continued printing with the
Ink option set to Color.

Follow the instructions on page 6-6 to print in black ink with an
empty color cartridge. Then replace the color ink cartridge
following the instructions in Chapter 6.

You're using the High
Speed (or BiD) and
MicroWeave settings with
a misaligned print head.

Turn off High Speed mode following the instructions in Chapter 2.
(If you’re printing with DOS, turn off Bi-D printing in default-setting
mode; see Chapter 5.) Then align the print heads following the
instructions in Chapter 6 (for Windows and Macintosh) or

Chapter 5 (for DOS).

Photographic images look grainy or rough.

Possible cause

Solution

The print heads are
misaligned.

Align the print heads following the instructions in Chapter 6 (for
Windows and Macintosh) or Chapter 5 (for DOS).

The resolution of your
image may be too low.

Increase the image resolution using your image-editing software,
or decrease the size of the image.

Color documents print in black ink only.

Possible cause

Solution

Your printer is not selected
in your application.

Select your printer and port in your software application.

Color printing is not
selected.

Select color printing in your application and the printer driver.

A color ink cartridge is
empty.

Check the Ink Out & lights and replace the color cartridge, if
necessary. See Chapter 6 for instructions on replacing ink
cartridges and printing with an empty color cartridge.
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All lights are off.

Solving Printing Problems

If the printer won’t print, first check that:
» The printer is turned on and the Operate light is on.
» Paper is loaded in the printer.

» The printer is plugged securely into a working electrical
outlet that’s not controlled by a switch or timer.

» The interface cable is securely connected to the printer and
computer and both are turned on.

If you still can’t print, check the following solutions.

Possible cause

Solution

The printer is not receiving
power.

Turn off the power and plug in the power cord securely.

Only the Operate light is on, but nothing prints.

Possible cause

Solution

The interface cable is not
connected securely or
does not meet both the
printer and computer
specifications.

Turn off your printer and computer. Then make sure the cable is
connected securely and meets both the printer and computer
specifications. For printer specifications, see Appendix C. For
computer specifications, see your computer documentation.

The printer has an internal
problem.

Turn off the printer and computer, disconnect the interface cable,
and run a printer self test as described on page 7-1.

Your printer or application
software is installed
incorrectly.

If the self test prints correctly, check your printer and application
software for correct installation. If you’re printing on a network,
make sure you set up your printer as described in Chapter 4.

Your computer doesn’t
have enough memory to
handle the data in the file
you are printing.

Try one of the following:

» Reduce the resolution of your image.

» Select fewer colors or a lower resolution for your monitor.
» Add more memory to your computer.

Printing is stalled in
Spool Manager
(Windows 95/3.1) or the
Windows NT print queue.

Delete the stalled print jobs in Spool Manager or the Windows NT
print queue and resume printing. See Chapter 4 for instructions.
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Possible cause

Solution

Printing is stalled in
Monitor2 (Macintosh).

Open the Extensions folder, EPSON folder, and Spool folder. Then
delete any queued files.

The print heads are clogged
or the ink cartridges are too
old.

If the printer sounds like it’s trying to print but doesn’t print
anything, clean the print heads; see Chapter 6 for instructions.

If cleaning doesn’t help, replace the cartridges. For information on
cartridge life and replacement instructions, see Chapter 6.

You’re using an
incompatible optional
interface board or one with
mismatched settings.

Check the specifications for your interface board and cable, making
sure they meet the printer’s requirements (see Appendix A) and
that they match your computer’s settings (see your computer
manual). Also make sure the Network I/F setting is turned on in
default-setting mode (see Chapter 5).

The Paper Out light is flashing or on.

Possible cause

Solution

If flashing, paper is
jammed.

Remove the paper and follow the guidelines for preventing jams
on page 7-16.

If on, paper is not loaded or
is loaded incorrectly.

Load paper or remove the stack and reload it as described in
Chapter 3. Then press the Load/Eject button to turn off the light
and resume printing.

If on, the paper-release
lever is set incorrectly for
the paper you loaded.

Set the paper-release lever forward for continuous tractor-fed
paper or backward for single sheets. See Chapter 3 for more
information.

An Ink Out & light is flashing or on.

Possible cause

Solution

If flashing, the ink supply is
getting low.

You need to replace the indicated ink cartridge soon. Make sure
you have a new cartridge, then see Chapter 6 for instructions.

If on, the ink cartridge is
empty.

You must replace the indicated ink cartridge; see Chapter 6 for
instructions.

All the lights come on briefly, then go off.

Possible cause

Solution

The printer’s voltage
doesn’t match your outlet’s
voltage.

Check the label on the back of your printer to determine its
voltage. If it doesn’t match your outlet’s voltage, turn off the
printer and unplug it immediately. Then contact your dealer.
Do not plug the printer back in.
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All the lights are flashing.

Possible cause Solution

An internal error may have  Turn off your printer, wait five seconds, and turn it on again. If the

occurred. lights still flash or stay on, contact EPSON as described in the
Introduction.

The printer has finished charging an ink cartridge, but the Pause light is still
flashing.

Possible cause Solution
The printer needs to If the light is still flashing after 10 minutes and printer is not
initialize. moving or making noise, turn the printer off. If the light is still

flashing when you turn it back on, contact EPSON as described in
the Introduction.

The printer sounds like it’s printing but nothing prints.

Possible cause Solution

The print head nozzles are  Clean the print heads. See Chapter 6 for instructions.
clogged.

The ink cartridges are too For information on cartridge life and replacement instructions, see
old. Chapter 6.

An ink cartridge is out of If you replaced an ink cartridge before it’s ink out light came on, the

ink. ink sensor was incorrectly reset. Replace the empty ink cartridge
with a new ink cartridge. See Chapter 6 for instructions. This
resets the ink sensor.

The printer software installed with Windows 3.1 does not work correctly after you
upgrade to Windows 95.

Possible cause Solution

Your printer software isnot  Reinstall the printer software after installing Windows 95, as
set up correctly for described in the Quick Setup booklet.

Windows 95.

After you install your printing software, you see the Windows 95 New Hardware
Found window.

Possible cause Solution

An operating system error  Click Do not install a driver, and then click OK.
has occurred.
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You see a spooling error message (Windows 95/3.1).

Possible cause

Solution

Spooling error messages or
very slow printing may be
caused by temporary files.

Change the Spool Manager default directory, following the
instructions in Chapter 4.

Your hard drive is too full.

Delete unnecessary files to make room on the drive.

Your computer doesn’t
have enough memory for
the file you’re printing.

Try one of the following:

» Reduce the resolution of your image.

» Select fewer colors or a lower resolution for your monitor.
» Add more memory to your computer.

In Windows 95, the Status Monitor box does not appear with the Despooler.

Possible cause

Solution

The Windows Print
Manager is interfering with
the Status Monitor.

Make sure Use Print Manager for this port is not checked in the
Spool Manager Queue setup. Then check your bidirectional spool
settings. See Chapter 4 for instructions.

You see a memory error message (Macintosh).

Possible cause

Solution

You may need to increase
the memory allocation for
your application, EPSON
Monitor2, or both.

Choose Get Info from the File menu when your application is
active and increase the memory requirements. See Chapter 4 for
more information. Or turn off background printing (you won’t be
able to use Monitor2).

A portion of your image doesn’t print (Macintosh).

Possible cause

Solution

Your system doesn’t have
enough available memory.

Close any other applications you are running or turn off
background printing.

You may need to increase
the memory allocation for
your application, EPSON
Monitor2, or both.

Choose Get Info from the File menu when your application is
active and increase the memory requirements. See Chapter 4 for
more information. Or turn off background printing (you won’t be
able to use Monitor2).




Troubleshooting

Printing is too slow.

Possible cause

Solution

Your printer software
options are set incorrectly.

For the fastest printing, try the following:

» Set Print Quality to Economy.

» Turn High Speed on.

» Choose No Halftoning.

» Choose Black ink.

See Chapters 1 and 2 for more information.

Your system doesn’t have
enough resources.

» Reduce the resolution of your image.

» Clear space on your hard disk drive or run a defragmentation
utility.

» Don’t run too many applications at the same time.

»  Turn off virtual memory.

» Increase your system’s memory (RAM).

You're using background
printing on a Macintosh.

Choose Get Info from the File menu when your application is
active and increase the memory requirements. See Chapter 4 for
more information. Or turn off background printing (you won’t be
able to use Monitor2).

Your Spool Manager
settings are incorrect
(Windows 95/3.1).

Change your default spool directory and other settings as
described in Chapter 4.

Your printer switches to the modem port or won’t confirm on the printer port

(Macintosh).

Possible cause

Solution

Your system has extension
conflicts.

Make sure AppleTalk is inactive. In the Extensions Manager,
disable the AppleShare, FileShare, and PrinterShare extensions.
Set your printer and any unused printers to the printer port. Then
restart your system.

You’re using an AppleTalk
cable.

Make sure you’re using a standard Apple System Peripheral-8
cable. See Appendix C for specifications.

Your printer icon doesn’t appear in the Chooser (Macintosh).

Possible cause

Solution

Your system has extension
conflicts.

In the Extensions Manager, disable Quick Draw GX. Make sure
EPSON Monitor2 and EPSON Stylus Color are enabled, then
restart your Macintosh.
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The “Sorry, EPSON Stylus COLOR cannot be used” message appears (Macintosh).

Possible cause

Solution

The printer driver has been
corrupted.

Remove and reinstall the driver:

1. From the printer software CD-ROM or floppy disk, click
Installer, click Continue, and select Custom Remove from the
pop-up list that displays “Easy Install.”

2. Select EPSON Stylus Series Printer Driver, and click
Remove. Click Continue, if necessary, and click Restart.

3. See the Quick Setup booklet for instructions on installing the
printer driver.

4. In the Extensions Manager, disable Quick Draw GX.

5. Make sure EPSON Monitor2 and EPSON Stylus Color are
enabled, then restart your Macintosh.

You turned the printer on and it is making noise.

Possible cause

Solution

The printer is charging the
print heads.

Wait until the printer finishes charging the print heads before you
print. If the printer has been turned off for a while (for example,
over the weekend), it needs to charge the print heads before
printing. This can take up to 10 minutes; do not turn off the printer
while the print heads are charging.

Fixing Paper Problems

You can avoid most paper handling problems by doing the
following:

»  Use smooth, high-quality media designed for ink jet
printers that meet the media specifications in Appendix C.

»  Make sure the paper is dry and flat before loading it.

» Follow all loading and handling instructions included with
the media and in Chapter 3.

If you have problems with paper feeding, paper jams, or ejected
paper, check here for solutions.
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Paper doesn’t feed correctly from the paper tray.

Try this

Then do this

Remove the stack of paper
from the paper tray.

Check that the paper:

Isn’t curled or creased.

Isn’t too thick or thin (see Appendix C).

Isn’t too old (see Chapter 3 or your paper packaging).

Isn’t overloaded in the feeder (see Chapter 3 for guidelines).

Isn’t jammed inside the printer. (If the Paper Out light is
flashing, paper is jammed. See page 7-16.)

Then reload the paper as described in Chapter 3, making sure that:

The paper-release lever is set backward to the single sheet
position.

The edge guides fit the paper’s width snugly, without any
slack.

The rear edge guide fits the paper’s length.

The paper tray and paper tray cover are fully extended if you
are printing on oversized paper.

No continuous paper is in the paper path. (Press Load/Eject to
park it out of the way.)

Paper doesn’t feed correctly from the manual feeder.

Try this

Then do this

Remove the paper from the
manual feeder.

Check that the paper:

Isn’t curled or creased.
Isn’t too thick or thin (see Appendix C).
Isn’t too old (see Chapter 3 or your paper packaging).

Isn’t jammed inside the printer. (If the Paper Out light is
flashing, paper is jammed. See page 7-16.)

Then reload the paper as described in Chapter 3, making sure that:

The paper-release lever is set backward to the single sheet
position.

The edge guides fit the paper’s width snugly, without any
slack.

The paper is loaded all the way into the manual feed slot.

No continuous paper is in the paper path. (Press Load/Eject to
park it out of the way.)
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Paper doesn’t feed correctly from the tractor feeder.

Try this Then do this
Remove the continuous Check that the paper:
paper from the tractor » Isn’t curled or creased.

feeder following the

. : Isn’t too thick or thin (Appendix C).
instructions on page 3-19.

Isn’t too old (see Chapter 3 or your paper packaging).

» Isn’t jammed inside the printer. (If the Paper Out light is
flashing, paper is jammed. See page 7-16.)

Then reload the paper as described in Chapter 3, making sure that:

» The paper-release lever is set forward to the continuous paper
position.

» The paper stack is close enough to the printer, but has room in
front and back to load and eject without obstruction.

» The paper’s holes are aligned on the sprockets, the sprockets
are locked and their covers are closed, and the paper is not too
slack.

» No single sheet paper is in the paper path. (Press Load/Eject to
eject any sheets.)

Before printing, check that:

» The paper source and paper size are set correctly in your
application or printer software. If you're using DOS, check the
Page Length setting in default-setting mode (see Chapter 5).

» The skip over perforation, auto tear-off, and banner modes are
set correctly for your media (see Chapter 5).

Multiple pages feed at the same time.

Try this Then do this

Remove the stack of paper. » Make sure the paper isn’t too thin (see the paper specifications
in Appendix C).

» Fan the edges of the stack of paper to separate the sheets.

» Reload the paper as described in Chapter 3, making sure to
load only the amount of paper directed for your media and
feeder.

» If more copies of a page or document are printing than you
expected, check that the Copies settings in both the printer
software and your application program are set to 1. See
Chapters 1 and 2 for information.
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Paper jams inside the printer.

Try this Then do this

Turn off your printer, open  You may need to turn the knob on the left side of the printer

the cover, remove any counterclockwise to eject all the torn pieces of paper. Never turn
loaded paper, and remove  this knob when the printer is on. You’ll lose the top-of-form
any little pieces that may position and may damage the printer. If you were printing labels,
have torn off inside. make sure there are no labels or adhesive stuck inside.

Then reload the paper as described in Chapter 3.

If your paper jams frequently, make sure you:

» Use smooth, high-quality paper, with the printable side loaded
correctly for your media type and feeder.

» Fan the stack and then even the edges before loading it.
» Don’t load too much paper for your media type and feeder.

» Adjust the edge guides or sprockets to fit the width of your
paper snugly, but without too much slack.

Paper doesn’t gject fully or is wrinkled.

Possible cause Solution

If the paper doesn’t eject Press the Load/Eject button to eject the paper. Then make sure

fully, you may have set the you select the correct paper size in your application software,

wrong paper size. printer software, or default-setting mode. (See the paper
specifications in Appendix C for the paper sizes you can print with.)

If it’s wrinkled when it See the paper specifications in Appendix C for paper thicknesses
comes out, the paper may  you can print with, as well as environmental requirements for
be damp or too thin. storage.




Troubleshooting

Solving Miscellaneous Printout
Problems

If your printout results are not what you expected, try these
solutions.

Characters are incorrect or garbled.

Possible cause

Solution

Your printer is not the
Windows default printer.

Select your printer as the default Windows printer. See your
Windows documentation or online help for instructions.

Your printer is not selected

in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup
booklet for instructions.

Your printer is not selected

in your DOS applications.

Select printer software for each DOS application you use, as
described in Chapter 5.

Printing is stalled in Spool

Manager (Windows 95/3.1)
or in the Windows NT print

queue.

Delete the stalled print jobs in Spool Manager or the Windows NT
print queue following the instructions in Chapter 4. Then try
printing again.

If you’re using background
printing on a Macintosh,
spooled data may be
corrupted.

Open the Extensions folder, EPSON folder, and Spool folder. Then
delete any queued files. Increase the memory requirements for
EPSON Monitor2 as described in Chapter 4.

The interface cable is not
securely connected.

Turn off your printer and computer. Then make sure the cable is
connected securely and meets the printer’s specifications.

You’re printing with DOS
and your software or
default-setting mode
settings are incorrect.

If you selected your font, pitch, character table, and line spacing
settings in your application software, make sure those settings are
correct. If you set them using your printer’s default-setting mode
(along with the Network I/F setting), follow the instructions in
Chapter 5 to make sure those settings are correct.

The printer’s parallel
interface transfer rate
doesn’t match your
computer’s transfer rate.

Make sure your computer and printer’s Parallel I/F transfer rate are
the same. Set the printer’s transfer rate using default-setting
mode. See Chapter 5 for instructions. If you are not sure what
settings to use, try setting both to Normal.
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The margins are incorrect.

Possible cause

Solution

Margins are set incorrectly
in your software
application.

Check your software documentation for instructions on selecting
the correct margins for your paper size. The maximum printable
width is 16.3 inches (416 mm) on any Size paper.

Make sure the margins are within the printable area of the page.
See Appendix C for more information.

Paper settings in the printer
software are incorrect for
your paper size.

Select the correct paper settings for your paper size. See
Chapters 1 and 2 for more information.

The image is inverted as if viewed in a mirror.

Possible cause

Solution

You used a Flip Horizontal
option in your application
software or the printer
software.

Turn off the Flip Horizontal or mirror setting in your application
software or the printer software. See Chapter 2 for information.
Remember that images printed on iron-on transfer paper and back
light film should be inverted so they appear correctly when
transferred or viewed from the reverse side.

The printer prints blank pages.

Possible cause

Solution

The print head nozzles are
clogged.

Clean the print heads following the instructions in Chapter 6.

Paper settings in the printer
software are incorrect for
your paper size.

Select the correct paper settings for your paper size. See
Chapters 1 and 2 for more information.

Your printer is not the
Windows default printer.

Select your printer as the default Windows printer. See your
Windows documentation or online help for instructions.

Your printer is not selected
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup
booklet for instructions.




Using Optional
Interfaces

Your EPSON Stylus COLOR 3000 includes both parallel and
serial interfaces so you can connect it to a PC or Macintosh, or
both at the same time. If you want to connect to another system
or to a network, you can install an optional interface board.

You can install one of the following EPSON interface boards in
your printer:

Type of interface board Model number Compatibility
Serial 823051 PC

32KB serial C832071 PC

32KB parallel C823101 PC

Twinax C823151 PC

Coax C823141 PC

LocalTalk C823121 Macintosh
Ethernet C823461 Macintosh/PC
Type B bidirectional C823452 PC

parallel

To order an interface board, contact your dealer or call EPSON
Accessories at (800) 873-7766 (U.S. sales only). In Canada, call
(800) 873-7766 for dealer referral.

This chapter tells you how to install and use EPSON interface
boards in the following sections:

»  Using Macintosh interface boards
»  Using the PC serial interface board

» Installing optional interfaces
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Using Macintosh Interface Boards

If you are planning to install the LocalTalk board, you also need
two LocalTalk Locking Connector Kits (DIN-8 version).
Attach one connector box to the AppleTalk interface on the
printer and the other to the printer port on the Macintosh.
Then attach the LocalTalk cable between the two connector
boxes. For more information, see the instructions that come
with the connector Kits.

If you install the Ethernet board connected to a thin coaxial
(10BASE?2) cable, and the printer is the last device on the
network, you need to obtain a 50-ohm terminator. The
Ethernet transceiver is included on the EPSON Ethernet board,
so you do not need an adapter box for the printer.

Using the PC Serial Interface Board

Before you install the serial interface board in your printer,
follow the instructions that come with the board for setting the
baud rate and parity. You may also need to set the board’s
handshake timing, error handling, and other data transfer
conventions. Refer to your computer documentation for
information about matching the board’s settings to your
computer system.
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Caution:

To avoid damaging your
printer or computer, do
not install the interface
board when the printer is
connected to an electrical
outlet.

Using Optional Interfaces

Installing Optional Interfaces

Before you install an optional interface board in your printer,
make sure the printer is turned off and all the printer’s lights are
off. Then follow these steps:

1.

Unplug the power cord from the electrical outlet (and from
the back of the printer, if your printer’s power cord is
removable).

Disconnect any interface cables from the back of the
printer.

Use a Phillips-head screwdriver to remove the two screws
securing the interface cover. Then lift off the cover.

Set any switches and jumpers on the interface board as
described in its manual. If your board has a jumper labeled
JG, make sure that you set it to ON, or the board will not
work properly.
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5. Slide the interface board along the slots on both sides of the
compartment. Push it in firmly to fully insert the board’s
connector into the printer’s internal socket.

6. Secure the interface board in the slot with the two screws
included with the board.

7. Connect the proper interface cable to the interface board
and to your computer. If the cable has a grounding wire,
connect it to one of the screws securing the interface board.

8. Reconnect any other interface cables you disconnected.

9. Make sure the printer is turned off. Then plug in the power
cord and turn on the printer.

In most cases, the printer automatically detects the interface
you're using. However, if you have trouble printing through an
installed interface board, you may need to change the printer’s
I/F (interface) mode setting using default-setting mode. See
page 5-3 for instructions.

To remove the interface board, first follow steps 1 and 2 in this
section. Remove the screws securing the board and carefully
pull it out of the internal printer socket. Then replace the
interface cover and screws you removed in step 3. Now you can
connect your printer using one of the built-in interfaces as
described in your Quick Setup booklet.



Using
EPSON Plot!

You can use the EPSON Plot! utility to open and scale HPGL or
HPGL/2 plotter files and then print them on your printer.

Follow the instructions in this Appendix to install the program
and print with EPSON Plot! and your Windows printer driver.

You can install and use EPSON Plot! on any system running
Windows 3.1, Windows 95, or Windows NT (3.51 or 4.0).
Make sure to connect the printer to that system and install the
printer software following the instructions in the Quick Setup
booklet before you begin.

Installing EPSON Plot!

Follow these steps to install EPSON Plot! on the system
connected to the printer:

1. Make sure Windows is running, but no applications are
open.

2. Insert the EPSON printer software diskette in a drive.

3. With Windows 3.1 Program Manager, open the File menu
and click Run.

With Windows 95 or Windows NT, click Start, then click
Run.



Using EPSON Plot!

\
Note: j

When you create plot
files for printing, use an
HPGL/2 driver whenever
possible. HPGL/2 drivers
do a better job of
maintaining the colors
assigned in your CAD
application than HPGL
drivers, which may limit

you to 8 or 16 pen colors.

Type ANSETUP (where A is the drive letter of your drive
and click OK.

Follow the instructions on the screen to install the program
on your hard disk.

The installation program creates an EPSON Plot! program
group or folder containing the program icon and icons for
Help, Readme, and Uninstall programs.

Printing With EPSON Plot!

Before starting EPSON Plot!, do the following to prepare for
printing:

Install the EPSON Stylus COLOR 3000 Windows printer
software on the computer connected to the printer. (See the
Quick Setup booklet for instructions.)

Turn on the printer.

Create an HPGL or HPGL/2 plot file using your plotter
software on any system.

Copy that plot file to the system connected to the printer, if
necessary.
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Now follow these steps to open EPSON Plot! and print:

1. Double-click the EPSON Plot! icon in the EPSON Plot!
program group or folder. You see the following screen:

2. Select Open File from the File menu.

3. Inthe Open File dialog box, choose the HPGL or HPGL/2
file you want to print and click OK. A representation of the
file contents appears in the Live Paper Space in EPSON
Plot!:

live paper
space

handle
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\
Note: j

The gray area around the
image represents the
area you cannot print on.

If you resize the plot
file, EPSON Plot! retains
the proportions of the
original and preserves
the X and Y coordinates.

If you print at 720- or
1440-dpi, you need to
rescale your image.
Otherwise it will print
smaller than what is
shown in the Live Paper
Space.

10.

11.

Select Printer Setup from the File menu.

Select the EPSON Stylus COLOR 3000 printer, if necessary,
and click Options. You see the Main printer settings menu.

Follow the instructions in Chapters 1 and 2 to select the
correct printer settings. Make sure to select the Paper
Source and Paper Size options for your paper and feeder
so EPSON Plot! can display the plot file contents exactly as
it will appear when you print.

When you're finished selecting your printer software
settings, click OK. Then click OK in the Print Setup dialog
box.

If you want to resize the plot file, click a handle in the Live
Paper Space and drag it to change the size. To reposition
the plot, click inside the image display and drag it into
position.

When the plot file looks how you want it to, select Print
from the File menu.

Click OK to print the file on your EPSON Stylus COLOR
3000.

See Chapters 1 and 4 for information on managing the
print job while it prints.

When you're finished printing with EPSON Plot!, select
Exit from the File menu to exit the program.



Specifications

Printing
Printing method On-demand ink jet
Nozzle configuration Monochrome (black) 128 nozzles

Color (cyan, magenta, yellow) 192 nozzles, 64 of each color

Printable columns and
printing speeds

Printing speed
Character pitch (characters per second)
(characters per inch) Printing column | Draft LQ
10 161 800 400
12 193 960 480
15 242 1200 600
17 (10 condensed) 276 1378 684
20 (12 condensed) 322 1600 800
Resolution Maximum 1440 dpi x 720 dpi
Print direction Bidirectional with logic seeking for text and graphics. (Auto print
direction can be set in the default-setting mode.)
Control code ESC/P 2 and expanded raster graphics code
IBM XL24E
Line spacing 1/6 inch (default), programmable in 1/8-inch and 1/360-inch
increments
Paper feed speed 100 milliseconds per 1/3-inch line
Input buffer 64KB



Specifications

Fonts

Bitmap fonts

Font 10 cpi 12 cpi 15 cpi Proportional
EPSON Roman X X X X
EPSON Sans Serif X X X X
EPSON Courier X X X —
EPSON Prestige X X X —
EPSON Script X X X —
cpi=characters per inch.

Select other font/pitch combinations using the ESC/P 2 commands as
described on page 5-17.

Scalable fonts

Minimum Maximum
Font point size point size Increments
EPSON Roman 8 32 2
EPSON Sans Serif 8 32 2
EPSON Roman T 8 32 2
EPSON Sans Serif H 8 32 2
Note:
\ The printer always uses the fonts you selected with your software application. You need to use the

! printer’s internal fonts only if your application doesn’t allow you to select fonts.

Character tables 1 italic and 26 graphics character tables
Character sets 14 international character sets and 1 legal character set
Note:
\ Character tables are selected with default-setting mode (see page 5-3 for instructions) or by using

! software commands (see page 5-17 for instructions).




Specifications

Paper
Paper type Size Paper types Thickness Weight
Single sheets Letter (8.5 x 11 inches) Plain bond paper and | 0.0031 to 0.0059 inch | Built-in sheet
A4 (210 x 297 mm) special ink jet papers | (0.08 to 0.15 mm) feeder:
A5 (148 x 210 mm) distributed by 17to 24 1b

Legal (8.5 x 14 inches)

Half Letter (5.5 x 8.5 inches)
Executive (7.5 x 10 inches)
A2 (420 x 594 mm)

Super A3/B (13 x 19 inches)
A3 (297 x 420 mm)

Ledger (11 x 17 inches)

US C (17 x 22 inches)

B3 (364 x 514 mm)

B4 (257 x 364 mm)

B5 (182 x 257 mm)

EPSON

(64 to 90 g/m?)
Manual feeder:
14 to 24 Ib

(52 to 90 g/m?)

Transparencies
and Glossy film

Letter (8.5 x 11 inches)

A4 (210 x 297 mm)

A6 (105 x 148 mm, glossy
film only)

Super A3/B (13 x 19 inches,
glossy film only)

Transparencies and
glossy film
distributed by
EPSON

0.005 to 0.006 inch
(0.13 to 0.15 mm)

Glossy paper

Letter (8.5 x 11 inches)
A2 (420 x 594 mm)
A4 (210 x 297 mm)

Glossy paper
distributed by
EPSON

0.0066 to 0.0070 inch
(0.17 to 0.18 mm)

Photo quality
Self adhesive
sheets

A4 (210 x 297 mm)

Self adhesive sheets
distributed by
EPSON

0.0079 inch (0.2 mm)
maximum

Envelopes

No. 10 9.5 x 4.1 inches
(240 x 104 mm)

Plain bond paper or
air mail paper

0.006 to 0.02 inch
(0.16 to 0.52 mm)

12to 24 Ib
(45 to 90 g/m?)

DL 8.7 x 4.3 inches
(220 x 110 mm)

C5 9 x 6.4 inches
(229 x 162 mm)

Index (ink jet) A6 (105 x 148 mm) Ink jet cards 0.0091 inch (0.23 mm)| 50 Ib
cards 8 x 10 inches (203 x 254 mm)| distributed by maximum (188 g/mz)
EPSON

Canvas cloth 16.5 inches x 9.8 ft Canvas cloth — —
(420 mm x 3 m) distributed by
EPSON
Banner paper 8.3t0 16.5 inches x 16.4 ft | Roll banner paper 0.003 to 0.004 inch 17to 22 1b

(210 to 420 mm x 5 m)

distributed by

(0.08 to 0.1 mm)

(64 to 82 g/m?)

EPSON

Back light film | A2 (420 x 594 mm) Back light film 0.0051 to 0.0055 inch | —
distributed by (0.13 to 0.14 mm)
EPSON
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Paper type Size Paper types Thickness Weight
Continuous Minimum size each sheet: Plain paper 0.0025 to 0.0039 inch | 14 to 22 Ib
paper 4 to 16 x 4 inches (0.065 to 0.1 mm) (52 to 82 g/mz)
(101.6 to 406.4 x 101.6 mm)
Continuous Minimum size each backing | Plain continuous Maximum total —
label paper sheet: label paper thickness:
4 t0 16 x 4 inches 0.0079 inch (0.2 mm)
(101.6 to 406.4 x 101.6 mm) Maximum label
Minimum label size: thickness:
2.5 x 0.94 inches 0.0047 inch (0.12 mm)
(63.5 x 23.9 mm)

Note:

Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always
test samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you
encounter problems, switch to a higher grade of paper.

Ink jet paper, envelopes, glossy film, glossy paper, transparencies, self adhesive sheets, back light
film, and canvas cloth are usable only under these conditions:

Temperature: 59 to 77 °F (15 to 25 °C)

Humidity: 40 to 60% RH

EPSON Photo Quality Glossy Film and Photo Quality Self Adhesive Sheets should be stored under
these conditions:

Temperature: 59 to 86 °F (15 to 30 °C)

Humidity: 20 to 60% RH

Printable areas

Single sheets and

index cards
) A: The minimum top margin is 0.12 inch (3.0 mm).
Aﬁ BL:  The minimum left margin is 0.12 inch (3.0 mm); except for A3
landscape, A2 portrait, US B landscape, and US C portrait, which are
Bl X ar 0.2 inch (5 mm).

BR:  The minimum right margin is 0.12 inch (3.0 mm); except for A3
landscape and A2 portrait, which are 0.2 inch (5 mm), and US B
landscape and US C portrait, which are 0.43 inch (11 mm).

%C C: The minimum bottom margin is 0.55 inch (14.0 mm).

Note:
\ The maximum printable width is 16.3 inches (416 mm)
! regardless of the paper size or feeder you use.




Specifications

Envelopes
A A: The minimum top margin is 0.33 inch (8.5 mm).
pEn BL, BR: The minimum left and right margins are 0.12 inch (3.0 mm).
BL~ - BR . o )
H-c C: The minimum bottom margin is 0.55 inch (14.0 mm).
Continuous paper
:3/\/‘0 A The minimum top and bottom margins above and below the
f° perforations are 0.35 inch (9.0 mm).
121 iz B: The minimum right and left margins are 0.51 inch (13 mm).
S — A
- o Note:
9: ; \ The maximum printable width is 15 inches (381 mm).
. Al
Ink Cartridges
Specification |Black (S020118) Cyan (S020130) | Magenta (S020126) | Yellow (S020122)
Print capacity* | 3800 pages/A4 (ISO/IEC 2100 pages (A4, 360 dpi, 5% duty each color)
10561 Letter Pattern at 360
dpi)
Cartridge life 2 years from production date, if unopened
Storage —22 to 104 °F (-30 to 40 °C)
temperature 1 month at 104 °F (40 °C)
Transit —22t0 122 °F (-30 to 50 °C) |-22 to 140 °F (-30 to 60 °C)
temperature 1 month at 104 °F (40 °C) 1 month at 104 °F (40 °C)
120 hours at 122 °F (50 °C) | 120 hours at 122 °F (50 °C)
Freezing 3.2 °F (-16 °C) -1.3°F (-18.5°C) [-5.8 °F (-21 °C) -0.4 °F (-18 °C)
temperature**
Dimensions 2.0 (W) x5.5 (D) x 4.2 (H) inches
25.1 (W) x 139.6 (D) x 105.3 (H) mm
* The print capacity may vary, depending on how often you clean the print head.

kel It thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
- O _ To ensure good results, use genuine EPSON ink cartridges. Other products may cause damage

-

to your printer not covered by EPSON'’s warranty.

Don’t use an ink cartridge if the date on the package has expired.




Specifications

Mechanical

Paper feed method
Paper path

Sheet feeder capacity

Total print volume
Dimensions

Width

Depth

Height
Weight

Electrical

\ Note:
Environmental

Temperature

Humidity

Friction, tractor feeder

Sheet feeder, front entry
Manual feeder, rear entry
Tractor feeder, rear entry

100 sheets of 17 Ib (64 g/m?) paper

For detailed information, see Chapter 3.

75,000 pages (A3, text only)

31.9 inches (810 mm)

22.3 inches (565 mm) maximum

9.4 inches (240 mm)

37.8 Ib (17.2 kg) without the ink cartridges

Specification 120V Model 220-240V Model
Input voltage range 103.5to 132V 198 to 264V
Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7A 0.4A

Power consumption

Approx. 21W (ISO/IEC 10561 Letter Pattern)

Operation: 50 to 95 °F (10 to 35 °C)

Storage: -4 to 140 °F (-20 to 60 °C), stored in shipping container
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Operation: 20 to 80% RH
Storage: 5 to 85% RH (stored in shipping container, without

condensation)

Check the label on the back of the printer for your printer’s voltage.




Specifications

Safety Approvals
Safety standards UL 1950 with D3, CSA C22.2 950 with D3
EMC FCC part 15 subpart B class B

Interfaces

Parallel interface

Forward channel Data format: 8-bit parallel, IEEE-1284 compatibility mode
Synchronization: STROBE pulse
Handshake timing: Busy and ACKNLG signals
Signal level: TTL compatible
Connector: 36-pin 57-30360 Amphenol connector or equivalent

Reverse channel Transmission mode: IEEE-1284 Nibble mode
Synchronization: Refer to the IEEE-1284 specification
Handshaking: Refer to the IEEE-1284 specification
Signal level: IEEE-1284 Level 1 device
Data transmission timing: Refer to the IEEE-1284 specification

Adaptable connector: 36-pin 57-30360 Amphenol Connector or
equivalent

Serial interface
Standard: Based on RS-423
Synchronization: Synchronous
Bit rate: Maximum 1.8 Mbps
Handshaking: X-ON/X-OFF, DTR protocol

Word format:
Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector: 8-pin mini-circular connector

Recommended cable: Apple System Peripheral-8 serial cable
(preferably Belkin brand)



banding

buffer

character table

characters per inch (cpi)

CMYK

ColorSync

default

dithering

dpi

driver

Glossary

The horizontal lines that sometimes appear when printing
graphics. See also MicroWeave.

The portion of the printer’s memory used to store data before
printing it.

A collection of letters, numbers, and symbols that provides you
with the characters used in a particular language.

A measure of the size of text characters, sometimes referred to as
pitch.

Cyan (blue-green), magenta, yellow, and black. These colored
inks are used to create the subtractive system array of printed
colors.

Macintosh software that is designed to help you get WYSIWIG
(what you see is what you get) output. This software prints
colors as you see them on your screen.

A value or setting that takes effect when the equipment is
turned on, reset, or initialized.

A halftoning method in which dots are arranged in an orderly
pattern. Dithering works best for printing images with solid
colors, such as charts and graphs. See also halftoning.

Dots per inch. The dpi measures the resolution. See also
resolution.

A software program that sends instructions to a computer
device to tell it what to do. For example, your printer driver
accepts print data from your word processing application and
sends instructions to the printer on how to print this data.



Glossary

Error Diffusion

ESC/P

ESC/P 2

Finest Detail

font

grayscale

halftoning

initialization

ink jet

interface

ips

This halftoning setting smooths out edges by randomly placing
dots of varying colors.

Abbreviation for Epson Standard Code for Printers. This
system of commands gives you control of your printer from
your computer. It is standard for all EPSON printers and
supported by most application programs for personal
computers.

The enhanced version of the ESC/P printer command
language. Commands in this language produce laser-like
features, such as scalable fonts and enhanced graphics printing.

This printer driver setting automatically makes your printed
images sharper and clearer. Be aware that this may increase the
time required for printing.

A style of type designated by a name.

A scale of shades of gray from black to white. Grayscale is used
to represent colors when printing with black ink only.

A method of using dot patterns to represent an image.
Halftoning makes it possible to produce varying shades of gray
using only black dots, or a nearly infinite array of colors using
only a few colors of dots.

Returns the printer to its defaults (fixed set of conditions). This
happens every time you turn on or reset the printer.

A method of printing in which each letter or symbol is formed
by precisely spraying ink onto paper.

The connection between the computer and a peripheral such as
a printer. Some printers have two interfaces, parallel and serial.
A parallel interface transmits data one byte, or eight bits, at a
time. A serial interface transmits data one bit at a time.

Inches per second. This scale is used to measure the printing
speed.



media

MicroWeave

monochrome

parallel interface

print queue

print server

printable area

printer driver

proportional printing

reset

resolution

RGB

scalable fonts

screen pattern

Glossary

Materials upon which data is printed, such as envelopes, plain
paper, special paper, and transparencies.

Printing technology that produces images in fine increments to
reduce the possibility of banding. See also banding.

This means printing with only one color of ink, which is
generally black ink.

See interface.

Print jobs that are sent to the printer while it is busy are stored
in a waiting line, or print queue, until they can be printed.

The computer connected to the printer. It receives the jobs and
then distributes them to the assigned printer. It also holds extra
print jobs while the printer is busy. See also print queue.

The area of a page on which the printer can print. It is smaller
than the physical size of the page due to margins.

See driver.

Printing in which the width of the character varies from
character to character. For example, a capital W receives much
more space than a lowercase i. The result looks more like a
typeset book than a typewritten draft.

To return a printer to its defaults either by sending a command,
an INIT signal or by turning the printer off and then back on.

The number of dots per inch used to represent an image.

Red, green, and blue. These colors, in phosphors irradiated by
the computer monitor’s electron gun, are used to create the
additive array of screen colors.

Fonts that can be enlarged or reduced. Non-scalable fonts are
called bitmap fonts and can’t change in size.

This feature prints shaded areas as they appear on screen,
instead of printing them as halftones.



Glossary

serial interface

spool

Spool Manager

Status Monitor

subtractive colors

See interface.

The process by which the printer driver converts the print data
into codes that your printer understands. This data is then sent
to the printer directly or to the print server.

An EPSON software program that converts print data into
codes that your printer understands. See also spool.

An EPSON software program that displays the printer’s status,
such as paper out or the amount of ink remaining before
printing.

Colors produced by pigments that absorb some colors of light
and reflect others. See also CMYK.



Accessories, EPSON, fi
Adhesive sheets, see Self adhesive
sheets
Adjust lever, see Thickness lever
Adjusting
cut-off position,
loading position, |3-21
margins, [3-12 [-15]-20]
tear-off position, [3-22
Advanced mode, 2-1]to -3, P-§]
Advanced settings

custom, [2-4 to[2-13
predefined, 2-1/ to[2-4
AGM settings, 5-6, b-19

Aligning print heads

control panel, 6-§ to
DOS utility, [5-7to
/-

problems,
utility, [6-7]
Alternate Graphics Mode, see
AGM settings
Assigning name to printer,
Auto
CR setting, [5-6]
I/F wait time set%, B-5

line feed setting,

sheet feeder, see Paper tray

tear-off, B-16/[3-19,[3-22
AutoCAD driver, I}, b-1
Automatic color adjustment, [2-9
Automatic mode, [L-3} [L-10} 2-6]

2963

Index

Back light film
choosing, [3-3|
flipping image, P-7]
loading,[3-33
printing from Macintosh,
3-35/t0 B-36]
printing from Windows,
to[3-35]
printing on, [3-4
specifications,
Back lit display, see Back light film
Background printing
Macintosh, [1-11, 4-7, [4-16]
12717
Windows, -1
background printing,
Banding, [7-4to[7-5
Banner mode, [3-24 [3-29,[3-32]
B-3357
Banners
choosing, [3-3| ‘
loading roll paper, [3-23|to [3-26
optional paper cutter, [3-23
paper specifications,
printing from Macintosh,
t0B-31
printing from Windows,
B-25t0B-29

removing roll paper,

Blank pages,|7-18
Blurry printouts,|7-6
Brightness setting, [2-9
Built-in sheet feeder, see Paper tray

Buttons, control panel,[1-14]




Index

CAD files,[B-2
Cancelling
print jobs, [L-7]
priﬁer software changes,
1-9
Canvas cloth, see Ink Jet Canvas
Cloth
Cards, see Photo Quiality Ink Jet
Cards
Character tables, 5-6, 5-8 to[5-17]
Characters, garbled, [7-17
Cleaning
print heads, 6-1]to[6-3
printer,[6-9]
sheets, special media, B-5 to B-6]
Coarse Dithering settin
Coax interface board,
Collate setting, [-4]
Color
Adjustment modes, P-9
custom settlngs 2 8 tow
problems, [7-5)
Colorimetric settin |2 1
ColorSync, P-3, ﬁ 2-10[to -1
Commands, printer,[5-16[to|5-1
Communication problems,
7303
CompusServe,
Continuous label paper
loading, [3-16]
Media Type setting,
Continuous paper

choosing settings for,

page length setting, [5-6
printing on, [3-15|to[3-19
removing, t0[3-20
specifications, [C-4|to
switching to single sheets,

Contrast setting,

Control codes,5-16ito €1

[(o] N

Control panel

buttons, [1-§| -

default-settinc moc

2-3
print head alignment,

[6-8t0fp-9

print head cleaning, [6-3
using,[1-14 to[1-16} [7-J to [-2,
[7-8[to[7-10
Copies setting, [L-

Current Settings box, [1-4,

Custom paper size,[3-23,[3-28)

Custom settings

deleting, P-13
print quality, [2-4to -7
project types, -3
refining, [2-13
saving, R-12|

special effects, P-4 to

Customer Care Centers, b

Cut-off position, 3-32]
Cyan setting, -9

Default printer options, setting,

L5 0l

Default-setting mode, [5-3|to[5-7]

Deleting print job, |4-3
Despooler, [1-7 to[L-§ 4-5

Dithering settings, |2-6




DOS
AutoCAD driver,
changing printer settings,
E-3067
character tables, to/5-1
default-setting mode,
print head alignment utility,
printer commands,
E-17t
problems,
selecting printer software for,
Download service, EPSON, f§
Draft printing, [2-3, P-6
Driver, help, [[-12to

Economy setting, -3, [2-6,

Electrical specifications,|C-6

Empty color ink cartridge, printing
with, [6-6, [7-7

Emulation, -5, b-17/to[5-19
ENERGY STAR,
Energy-saving tips,

Envelopes
Media Type setting, [3-3]

thickness lever setting, [3-7
3-1
Environmental specifications, [C-6
EPCALIB utility, 5-7top-§ 9
EPSON
Accessories, f
Customer Care Centers, §
Download Service, §
Electronic Support Services,
Atof7
FaxAdvice, [
help, [ to[7
media, [3-3|to[3-4]

Monitor2 utility, 6| to[4-7]
Namer utility,}4-1
Plot!, B-1to B-4

Stylus PowerPlug, [-9]
World Wide Web site, f

Index

Error Diffusion setting,
ESC (~ command,
ESC R command,
ESC/P 2,p-5,
ESC/P 2,
Ethernet interface board,
ATop7

Extension module, Power

Macintosh,

Faint printouts, [7-6,

FaxAdvice, EPSON,

Film, see Photo Quality Glossy
Film

Fine Dithering setting, P-6

Finest Detail setting, R-7]

Flip Horizontal setting,2-7, B-4,
3-35, B-36) 19

Fonts, b-5

Garbled characters,

Glossy media, see Photo Quality
Glossy Paper, Photo Quality
Glossy Film

Graph-type projects, settings for,

Halftoning setting,
Head Cleaning utility,
Help
EPSON, B to |/
online, to
Hex dump, printing,
High quality glossy paper, see
Photo Quality Glossy Film
High Quality Ink Jet Paper
choosing,
printing on, [3-4
specifications,
High Speed setting,
Horizontal banding,
Host system, network setup, |4-12
HPGL files, printing, B-1to[B-




Index

I/F mode,[B-5]
IBM XL24E emulation, [5-5, -19
ICM (Image Color Matching), -3
Improving print quality, [7-4 to [f-7]
Incorrect
characters,
margins,|7-18
Index cards, see Photo Quality Ink
Jet Cards
Ink
moﬂtoring level, [L-7]to[1-§]
setting, [1-3|

Status, [L-§]
Ink cartridge
printing with empty color,
problems,|7-6
replacing, |6-4 to -5
specifications,
Ink Jet Back Light Film
choosing,
flipping image, P-7]
loading, [3-33)
printing from Macintosh,
3-35/10[5-36)
printing from Windows,
B-34to
specifications,
Ink Jet Canvas Cloth
choosing, B-3|

Media Type setting, [3-4|

printing on, [3-23|to|3-31

removing, t0[3-33
specifications, [C-3

Ink jet cards

choosing,
printing on, [3-4, B-11
specifications,

Ink jet paper

choosing,
printing on, [3-4
specifications,

Ink Jet Transparencies

choosing,
printing on, [3-4
specifications, |C-3|to Fg

Interface (I/F) mode, 5-6,

Interface boards
cables,
installin
parallel,
problems,
removing,
serial, A-2

Interface specifications,|C-7

International character sets, b-6,
619

Iron-On Transfer Paper
choosing, [3-3
printing on, [2-7, 3-4

Italic character set,|5-6}|5-15

Jammed paper,[1-14, [/-9 [7-16]

Labels
corlm%ous label paper,
3-16
Media Type setting,
specifications,
tear-off position, |3
Landscape setting, [1-4

Lights, control panel,[1-14]to [L-15)
73 780
Line spacing,

Loading position, adjusting, B-21]
LocalTalk interface board,

A-TtA-2




\/] Macintosh, [[-11]

background printing, -7} [4-16]

ColorSync E [-§
B-10jt0p-T

interface boards,

interface specifications, [C-7]

managing print jobs from,
[4-6]to[4-9)

Monitor2, -1

network printing, i-15 to[4-16]

online help, |1ﬁg|

printing from, [1-9 to|1-11|

problems,|7-11to|7-13}[7-17|

Magenta setting,

Maintaining prlnter b-1t0p-9
Managing print jobs

Macintosh, {4-6|to 4-9

Windows, [1-7 to [L-§ -1 to[4-6]
Manual feeder, to
Margins

adjusting, 3-12} B-15, B-20)

problems,[7-18

specifications, [C-4|to|C-5
Mechanical specifications,
Media Check, [L-§

Media 'I;yEpe setting,[1-3,[-11, -3,

Memor proble
17

Messenger servrce Windows NT,
o
Micro Adjust buttons,3-20]to B-22]
MicroWeave setting, P-7]
Mirror images,[2-7,[3-4,[3-3
-18
Monitor2 utility, @to 4-7
Mcﬁormg ink level, [I-7to [L-§|
4-5
M(ieSettinﬁ dialog box,
to
Moving printer,[6-9to[6-10]

O

Index

Namer utility, EPSON,[4-15
Network

I/F mode setting,
path, [4-13to
Network printing

Macintosh, [4-15]to

problems, [/-6
Windows, 4-9 to -14
New Hardware Found window,

0
No Color Adjustment setting,[2-9)
No Halftoning setting,@
Nozzle Check

pattern
utility, |6-2]

Online driver help, to|1-13
Optional interfaces, A-1]to
Orientation setting, [L-4, [L-9

Page length setting,
Page Setup dialog box,
Paper
coated, B-1]
glossy, see Photo Quality Glossy
Paper
handling problems,
7-13)to
jams, (1-14{|7-16
loading guidelines, B-3 to B-6]
menu,[1-4,-9
monrtormg amount, [L-7/to[1-§]
plain,
specrfrcatrons -3o[CH
tray, B-7to '
Paper size, custom, 3-23|
Paper Status, [L-8]
Paper-release lever,|1-14} [3-16)

B-21] B-23| B-24 [3-33




Index

Parallel 1/F transfer rate setting,

Parallel interface boards, [A-]]

Pen colors, B-2

Perceptual setting, [2-11]

Photo Quality Banner Paper
choosing

Ioading,'é—zé to

optional paper cutter, 3-23]
printing on, [3-26|to|3-31
removing, to

Photo Quality Glossy Film
choosing, [3-2
printing on, [3-4
specifications, to

Photo Quality Glossy Paper
choosing, 3-2
printing on, [3-4
specifications,

Photo Quality Ink Jet Cards

choosing, 3-2
printing on, [3-4| B-11
specifications,

Photo Quality Ink Jet Paper
choosing, [3-2
printing on, [3-4
specifications, |C-3

Photo Quality Self Adhesive Sheets
choosing,
printing on, [3-4
specifications, |C-3

Photo setting, [2-3

Photo-realistic color adjustment,

Pitch setting, [5-5

Plotter files, B-1|to[B-4

Portrait setting, [1-4|

Power Macintosh Extension
module, [1-9]

Predefined advanced settings,
E1p-a

Print direction setting, 5-5

Print head alignment

control panel, 6-§ to
DOS utility, [5-7|to
/-5

utility, [6-7,

Print job, deleting, [4-3]

Print quality problem@ to[7-7]

Print Quality setting,
Print queue,
Print using a Temporary File
setting,
Printable aEa,, [C-4w[cH
Printer
cleaning, 6-9
commands, to

stand, 9

test, [7-2|to[7-3

transporting, [6-9|to[6-10]
Printer driver, accessing

Control Panel,[I-5/to

Macintosh applications,

Windows applications, [1-2
Printer software, using,

Printer status
Macintosh, {4-6|to
Windows, [1-7 to [L-§ -4 to[4-5]

Problems
communication, [7-2)to[7-3

diagnosing, [7-1 to
paper handling,

print quality, [7-4
printing, [7-8to
solving, [7-1| to
unexpected printout results,
Tof Ty

Quality/Speed slider,[1-4,[L-17, 2-2]

Re%te systems, network setup,

Removing driver,[7-13

Rendering Intent setting,[2-1]]

Replacing ink cartridges,
6-4to[6-5.[7-6,[7-10

Resolution, R-6}

Reverse order setting,



Roll paper
choosing
loading,
printing on,
specifications,

Safety
approvals,
instructions, [ to
Saturation setting, [2-9
Self adhesive sheets
choosing,
loading,
Media Type setting, B-4]
specifications,
Self test, [7- to[7-3
Serial interface boards, [A-1]to [A-2
Service, B to ff
Sheet feeder, see Manual feeder,
Paper tray
Single sheets
printing on, 3-3, B-6/to[3-15]
switcﬂm to continuous paper,
3-2
Skip over perforation setting, @

Slashed zero,[5-3, B-
Smeared printouts, [7-6 to[7-7]
Special effects settings, -4/ to

Specifications

electrical, [C-§]

environmental,

paper, to
printing,|C-1
Spool directory,
Spool Manager
problems,[7-8 [7-11] [7-17]
using, B-2[to

Status Monitor

problems,
Windows, [1-8,
Support, EPSON, Hto[/]

System requirements

Macintosh,
Windows,

Tear-off position
adjusting,
for labels,
Technical specifications,
C-TlocT]
Temporary file, print setting, ﬂ
Temporary print job files, [4-2|
Testing printer,lﬁto -
Text/Graph setting, |2-3
Thickness lever, 3-7,B-13,
Transfer paper, see Iron-On
Transfer Paper
Transparencies

choosing,
printing on, [3-4
specifications, [C-3]to [C-4

Transporting printer, [6-9 to[6-10

Troubleshooting, [7-1]to[7-18]

OO

Twinax interface board,

User Defined paper size, 3-28

Utilities
EPCALIB,5-7|to[5-8
EPSON Monitor2, [4-6|to 4-7]
EPSON Namer, |4-15
Head Cleaning,
Nozzle Check, [6-2/to
Print Head Alignment,
Status Monitor, see Status

Monitor

Vertical banding, [7-5]
Vertical lines, misaligned,[2-7]
-7tof-9. [
see also Print Head Alignment
Video/Digital Camera setting, E
0

2-10
Vivid color adjustment, P-9
Voltage,

Index



Index

\/\/ What's This prompt, -3 [1-12]
113

w

ndows
checking printer status,
to
maglngﬂnt jobs from,
1|to}4-6
network printing, -9 to[4-14

online help,[1-12
printing from, [L-1to f-5

problems,|7-10/to[7-11]

-t

setting default printer options,

[1-5]to[1-6]

Spool Manager,
Windows 95, ICM,

Windows NT

World Wide Web site, EPSON, f

checking printer status,
network printing, -9 to
online help,[1-13

setting default printer options,

[L-6lto[L-7]

X
Y
Z

XL24E emulation, IBM, p-5,[5-19

Yellow setting, P-9

Zero setting, 5-6]
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